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Copyright, Trademark, and FCC 
Information 

Copyright 

This document is copyrighted by Osprey Technologies, Inc., a wholly-owned 
subsidiary of ViewCast Corporation. No part of this specification may be reproduced, 
transcribed, transmitted or stored in a retrieval system in any part or by any means 
without the express written consent of Osprey Technologies, Inc. 

Disclaimer 

Osprey Technologies, Inc. reserves the right to change any products herein at any 
time and without notice. ViewCast Corporation and Osprey Technologies, Inc. make 
no representations or warranties regarding the content of this document, and 
assume no responsibility for any errors contained herein. 

Trademark Acknowledgment 

Osprey-210, Osprey-220 and Osprey-230 are trademarks of Osprey Technologies, 
Inc. Microsoft, Windows 2000, Windows NT, Windows XP, NetMeeting, NetShow, and 
Video for Windows are trademarks or registered trademarks of Microsoft Corporation. 
Any other product names, trademarks, trade names, service marks, or service 
names owned or registered by any other company and mentioned herein are the 
property of their respective companies. 

FCC Notice 

This device has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
device generates, uses, and can radiate radio frequency energy, and if not installed 
and used in accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference will not 
occur in a particular installation. If this device does cause harmful interference to 
radio or television reception, the user is encouraged to try to correct the interference 
by one or more of the following measures: 

♦ Reorient or relocate the receiving antenna. 

♦ Increase the separation between the computer and the receiver. 

♦ Connect the computer into an outlet on a circuit different from that to which 
the receiver is connected. 

♦ Consult the dealer or an experienced radio/TV technician for help. 

Shielded Cables 

Connections between this device and peripherals must be made using shielded 
cables in order to maintain compliance with FCC radio emission limits. 



 

Modifications 

Modifications to this device not approved by Osprey Technologies, Inc. could void the 
authority granted to the user by the FCC to operate the device. 

Note to CATV Installer 

This reminder is provided to call to the CATV installer's attention Section 820-40 of 
the NEC, which provides guidelines for proper grounding and, in particular, specifies 
that the cable ground shall be connected to the grounding system of the building, as 
close to the point of cable entry as practical. 
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Chapter 1 - Getting to Know the Osprey-
210, Osprey-220 and Osprey-230 Cards 

The Osprey-210, Osprey-220 and Osprey-230 Capture Driver User’s Guide provides 
practical information for installing and configuring the hardware and software for the 
Osprey-210, Osprey-220 and Osprey-230 devices. This guide has been designed with 
the needs of the end user in mind, particularly first-timers and those working with 
existing applications. 

♦ Symbols 

♦ Introduction 

♦ Osprey-210, Osprey-220 and Osprey-230 

♦ Features 

♦ Software Included 

♦ Compatible Third-Party Applications 

♦ Getting Help 

Symbols 

 
This symbol denotes an important note or warning. 

 

This shortcut icon points more experienced users to sections or chapters 
that summarize step-by-step instructions. 

Introduction 

Osprey Multimedia Capture Cards provide economical solutions for capturing video 
images in an uncompressed digital format. All formatting and scaling of images are 
processed within the hardware, allowing for maximum system efficiency and speed.  
The Osprey-200 series also provides on-board audio capture capability. 

This Users’ Guide covers two main models of Osprey Multimedia Capture Cards: 

♦ Osprey-210 – Basic audio and video capture 

♦ Osprey-220 – Audio and video capture with professional audio inputs 

♦ Osprey-230 - Universal 3.3V/5V PCI card with audio and video capture with 
professional audio inputs for Windows2000 and Windows XP only 

These products consist of a PCI board (based on the Conexant Bt878A single-chip 
video capture device) and Video for Windows compliant software drivers for Windows 
2000, Windows XP, Windows NT 4.0, and Windows 95/98 platforms. 
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The driver for Windows 95/98 is a separate driver with its own Users’ Guide. All 
information in this Users’ Guide refers to the Windows 2000, Windows XP, and 
Windows NT drivers.   

 
The Osprey-230 is not supported under Windows NT or Windows 95/98. 

Osprey-210, Osprey-220 and Osprey-230 

The Osprey-210, Osprey-220 and Osprey-230 include both audio and video capture 
capabilities.  All three of these cards support NTSC and PAL video capture in 
standard RGB and YUV formats.  They also support video scaling.  For audio 
processing, they sample at 32kHz, 44.1kHz, and 48kHz.  The Osprey-220 and 
Osprey-230 includes a breakout cable for the audio and video connectors, XLR 
connectors, and balanced audio.  The Osprey-210 also includes a breakout cable. 

Features 

The driver supports all Video for Windows capture driver capabilities that are 
available to the Bt878 / Ct878A hardware device. It is compatible with software 
video compressors, sound boards, video editing applications, and videoconferencing 
applications. 

Audio/Video Specifications 

Video Frame Rates and Performance 

Audio/Video Specifications 

Video Input 

♦ NTSC/PAL 

♦ Composite (BNC connector) 

♦ S-Video (mini-DIN connector) 

Audio Input 

♦ Unbalanced stereo (the Osprey-210, Osprey-220, and Osprey-230 cards have 
RCA connectors; the Osprey-210 also includes a 3.5 mm stereo connector) 

♦ Osprey-220 and Osprey-230 ONLY: Balanced stereo (XLR connectors) 

Audio Output 

♦ Hardware loopback for monitoring of audio input (3.5mm stereo connector) 
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Audio Processing 

♦ Auto sample rate selection for analog inputs (32 kHz/44.1 kHz/48 kHz) 

♦ Audio sample rate down conversion based on application requirements 

Computing Platforms 

♦ Windows 2000 Professional 

♦ Windows XP 

♦ Windows NT 4.0 (the Osprey-230 is not supported under Windows NT) 

Hardware System 

♦ 32-bit/5-volt PCI card (Osprey-210 and Osprey-220) 

♦ Full PCI Rev. 2.2 compliance (Osprey-210 and Osprey-220) 

♦ Multi-board support 

♦ Full PCI Rev. 2.3 compliant universal 3.3V/5V card (Osprey-230) 

♦ Operates in either 32-bit or 64-bit slots at speeds up to 66 MHz (Osprey-230) 

Video Frame Rates and Performance 

The Osprey-210, Osprey-220 and Osprey-230 can deliver to the host 30 frames per 
second (fps) full resolution NTSC (720x480) as well as 25 fps full resolution PAL 
(720x576). The Osprey-210, Osprey-220 and Osprey-230 use Direct Memory Access 
(DMA) to efficiently perform this delivery of both video and audio data to the host. 
Once the data is in host memory, performance is directly affected by how the data is 
processed.  

The Osprey-210, Osprey-220 and Osprey-230 also support DirectDraw for displaying 
video with minimal load on the system processor. 

It should be noted that uncompressed video bandwidth is very large. Video at 
640x480 with a 16bit color format at 30fps results in more than 18Mbytes/sec of 
data transfer across the PCI bus. Thus PCI bandwidth issues, which may result due 
to other high bandwidth demanding devices on the PCI bus, can limit performance. 
For example, having PCI based SCSI controllers may consume large amounts of PCI 
bandwidth if lots of SCSI disk activity is occurring.  
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Software Included 

The products for Windows 2000, Windows XP, and Windows NT 4.0 include: 

♦ A Video for Windows compatible video capture driver 

♦ An audio mixer and an audio wave (capture) driver 

♦ A simple audio/video capture application from Microsoft using the 
DirectX/DirectShow API 

♦ VidCap32 – Another audio/video capture application from Microsoft 

♦ A Control Panel applet 

♦ Ligos Technology's Indeo package of software-based audio and video codecs 
and compressors 

 
The Osprey-230 is not supported under Windows NT. 

Beginning with Version 2.0.0, the driver is SimulStream capable.  SimulStreaming is 
an added-cost upgrade that allows the driver to capture and display video and audio 
to multiple destinations from a single card.  Please see the SimulStreaming User’s 
Guide which is installed in the Osprey MultiMedia Capture Program group for details 
about this feature. 

Compatible Third-Party Applications 

The Osprey-210, Osprey-220 and Osprey-230 work with any Video for Windows 
compatible application. For the latest product news, please continue to visit our 
ViewCast Corporation web site http://www.ospreyvideo.com/ for the Osprey-
210, Osprey-220 and Osprey-230.  

Getting Help 

Before contacting support, please do the following: 

♦ Work through the section of Chapter 3 entitled Testing the Installation for 
Windows 2000 Chapter 4 entitled Testing the Installation, or Chapter 5 
entitled Testing the Installation for Windows NT. 

♦ Read through Chapter 9 - Troubleshooting. 

♦ Visit our web site at http://www.ospreyvideo.com/ and read the Osprey-
210, Osprey-220 and Osprey-230 FAQs by selecting Osprey-200, then 
clicking on the FAQ button. 

http://www.ospreyvideo.com/
http://www.ospreyvideo.com/


 Chapter 1 - Getting to Know the Osprey-210, Osprey-220 and Osprey-230 Cards 

ViewCast Corporation Osprey-210, Osprey-220 and Osprey-230 User's Guide – 15 

If you have done that and you’re still having problems, contact the Osprey Support 
Group at: 

Voice, toll free (888) 684-6622 

Voice (919) 319-9200 

Fax (919) 319-9814 

Support http://www.ospreyvideo.com and 
click Support 

When you contact support, especially if it is by email, please include the following 
information: 

♦ Which product you have – Osprey-210 or Osprey-220 or Osprey-230. 

♦ Which operating system you are using. Certain minor aspects of the Osprey 
drivers are different between Windows 2000, Windows XP, and Windows NT 
4. 

♦ Which version of the Osprey driver you are using. The version information is 
on the title bar of the driver’s Control Dialog, as well as in the first message 
of the installation program. 

♦ The type of audio and video source being used (for example: S-video video 
and composite audio) and the type of equipment being used as the source 
(for example: a DVD player). 

♦ Any additional details about your system configuration would be helpful – for 
example, the system speed, processor type, motherboard chipset, whether 
you have a SCSI or IDE hard drive, whether you have a network adapter 
card, and the type of display adapter card. 

♦ A detailed description of the problem.  

http://www.ospreyvideo.com/
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Chapter 2- Osprey-210, Osprey-220 and 
Osprey-230 Hardware 

The Osprey-210 and Osprey-220 Capture Cards are 32-bit, 5-Volt PCI cards. They 
are compliant with version 2.2 of the PCI hardware specification.  

The Osprey-230 Capture Card is a universal 3.3V/5V PCI card that will operate in 
either 32-bit or 64-bit slots, and is compliant with version 2.3 of the PCI hardware 
specification. 

♦ System Requirements 

♦ Configuring the Video Capture Driver 

♦ Installing the Card 

♦ Connecting Cables 

System Requirements 

The minimum capability of the computer for the capture card itself is fairly low.  It is 
typically the application being used with the capture card that sets the minimum 
requirements of the computer.  For example, pure video capture applications 
typically do not require hefty machines.  Yet the various streaming encoding 
applications, for example RealProducer or Windows Media Encoder, may require up 
to dual 2 GHz processor for some of their challenging encoding profiles. 

For x86 PCs, the minimum system requirements are as follows: 

♦ 300 MHz Pentium II processor or higher with at least 128Mb RAM  

♦ One available PCI slot 

♦ Windows NT 4.0, Windows 2000, or Windows XP, 

♦ Approximately 7.5 megabytes of storage for system files 

For optimum performance, we recommend at least the following additional features. 

Video display adapter with: 

♦ 4 MBytes memory minimum (8 Mbytes or more recommended) 

♦ Direct Draw capability 

♦ An up-to-date display device driver with Direct Draw capability 

Configuring the Video Capture Driver 

Use the video capture application AmCap to access the Osprey driver Control Dialog 
described in Chapter 6 - Osprey-210, Osprey-220 and Osprey-230 Video 
Control Dialog. 
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VidCap32 is included with the Osprey package. It is useful for testing the installation 
and for general purpose viewing of video. Refer to Chapter 8 for instructions on 
using this applet.  

Installing the Card 

 

All computer cards are sensitive to electrostatic discharge. Slight 
discharges from clothing or even from the normal work environment can 
adversely affect these cards. By following these simple guidelines, 
however, you can minimize the chance of damaging your Osprey card. 

To be used only with UL Listed computers that include instructions for 
user installed accessories. 

♦ Handle cards only by the non-conducting edges. 

♦ Do not touch the card components or any other metal parts. 

♦ Wear a grounding strap while handling the cards (especially when 
located in a high static area). 

♦ Provide a continuous ground path by leaving the power cord 
plugged into a grounded power outlet. 

♦ Ensure that the workstation is powered OFF before installing any 
components. 

 

If you are not familiar with how to install a PCI bus card, refer to your 
system’s documentation for more complete, step-by-step instructions. 

You should install the Osprey card before installing the software driver. However, 
with Windows 2000 and Windows XP you also have the option to pre-install the 
software before installing the hardware. 

Use the following steps to install the Osprey card:   

1. Power down the computer. Make sure that the computer’s power switch is 
turned OFF. Read caution note above for grounding precautions. 

2. Remove the computer’s cover. 

3. Locate an empty PCI slot. 

4. Remove the slot-cover screw from the empty PCI slot’s cover, set the screw 
aside, and remove the slot cover. 

5. Remove the card from its anti-static bag. 

6. Install the Osprey card into the empty slot and make sure that it is seated 
evenly in the slot. 

7. Secure the backpanel of the card with the slot’s cover screw. 

8. Replace the computer cover. 

9. Connect video and audio cables to the Osprey card. Refer to Connecting 
Cables for details of the card’s backpanel connector. 

10. Turn the computer on.  
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Connecting Cables 

Connecting a Composite Source 

Connecting an S-Video Source 

Connecting Audio with the Osprey-210, Osprey-220, or Osprey-230 

The Osprey-210 and 220 now have the same connectors on the backplate for audio 
and video.  The Osprey-210 has a new design to incorporate improvements to the 
board. 

Osprey-210 Classic Backplate 
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Osprey-220, Osprey-230, and redesigned Osprey-210 
Backplate 

 

The Osprey-230 is assembled with a backplate for standard systems.  However, the 
package also includes an additional backplate designed for low profile systems.   

 
Do not try to utilize the low profile backplate in standard systems.   

To use the low profile backplate, remove the standard backplate by removing the 
screws which connect the backplate to the board.  Position the low profile backplate 
and replace the screws. 
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Osprey-210 Input Breakout Cable 

 

Stereo Audio 
(3.5 mm style) 

S-Video 

Unbalanced Audio 
Left (RCA style)

Unbalanced Audio 
Right (RCA style) 

Composite Video 
(BNC style) 

S-Video 

RCA style 

Connector Styles 

 

The breakout connector has inputs for composite video, S-Video and unbalanced 
audio.  

 

The Osprey-210 breakout cable includes three audio inputs.  You should 
not connect an audio source simultaneously to all three connections.  
Either connect a stereo 3.5 mm cable to the input or an RCA-style audio 
cable. 

 
The input breakout cable is ViewCast Part Number 34-05010-01. 
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Osprey-220 and Osprey-230 Input Breakout Cable 

The Osprey-220 card previously included a breakout box.  Now the breakout box has 
been replaced with the breakout cable.   

 S-Video 
Unbalanced Audio 
Left (RCA style) 

Unbalanced Audio 
Right (RCA style)

Composite Video 
(BNC style) 

Balanced Audio 
Left (XLR style) 

Balanced Audio 
Right (XLR style) 

S-Video 

RCA style

XLR style 

Connector Styles 

 

The breakout connector has inputs for composite video, S-Video, balanced and 
unbalanced audio, and professional digital audio. The breakout cable has a set (L/R) 
of unbalanced RCA style audio connectors and a set (L/R) of balanced (XLR) audio 
connectors. Additionally, the right XLR balanced input also is used as the professional 
digital audio input. 

 
The input breakout cable is ViewCast Part Number 34-05009-01. 
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Osprey-220 and Osprey-230 Input Rack-mount Panel 

 

A rack mount version of the breakout box is also available. The 1 unit high rack 
mount input box has the same inputs as the breakout box but includes two sets of 
inputs. Thus a single rack mount input unit provides for two Osprey-210, Osprey-
220, or Osprey-230 cards. The rack mount unit is pictured above. 

 
The rack-mount breakout box is ViewCast Part Number 95-00151-02. 

 
Exact connector layouts are subject to change. 
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Osprey-220 Input Breakout Box 

The Osprey-200 card previously included a breakout box.  Now the breakout box has 
been replaced with the breakout cable.   

 

The breakout connector has inputs for composite video, S-Video, balanced and 
unbalanced audio, and professional digital audio. The breakout cable/box has a set 
(L/R) of unbalanced RCA style audio connectors and a set (L/R) of balanced (XLR) 
audio connectors. Additionally, the right XLR balanced input also is used as the 
professional digital audio input for the Osprey-500 PRO and Osprey-500 DV PRO. 

 
The input breakout box is ViewCast Part Number 95-00157-01. 

Connecting a Composite Source 

If your video source provides only composite video, connect the source’s output 
cable to the Composite Video In connector. 

Connecting an S-Video Source 

If your video source supports S-Video, connect the source’s output cable to the S-
Video In connector. Compared to composite signals, S-Video provides a sharper 
image with better color separation. S-Video uses a four-pin mini-DIN connector that 
provides separate Y (luminance) and C (chrominance) signals. Refer to Chapter 6 - 
Osprey-210, Osprey-220 and Osprey-230 Video Control Dialog for instructions 
on configuring the driver for S-Video.  
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Connecting Audio with the Osprey-210, Osprey-220, or 
Osprey-230 

The Osprey-210, Osprey-220 and Osprey-230 audio connectors are made for line 
level audio stereo equipment, such as VCR or DVD outputs and can also take 
headphone level outputs when the volume is adjusted midway between high and low 
settings.  It should be noted that if you are using a camcorder or VCR with only a 
single audio output, the volume needs a slight adjustment. 

Although the Osprey-210, Osprey-220 and Osprey-230 accept line level inputs, the 
standard microphone shipped with most soundcards is not compatible. You need to 
use a powered microphone using connectors with 1-volt peak to peak output.  

The following connector types are used on the boards: 

♦ Osprey-210 - 3.5 mm stereo connector and RCA-style connectors for line-
level audio 

♦ Osprey-220 and Osprey-230 - RCA-style connectors for left and right line-
level audio 

The selection of audio input to capture is independent of the video input selection.  

 

The Osprey-210 breakout cable includes three audio inputs.  You should 
not connect an audio source simultaneously to all three connections.  
Either connect a stereo 3.5 mm cable to the input or an RCA-style audio 
cable. 
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Chapter 3 - Installing the Software - 
Windows 2000 

 

The Windows NT 4.0 Osprey drivers do not work with Windows 2000. If 
your Osprey card(s) were installed under the Windows NT 4.0 operating 
system and the PC has now been upgraded to Windows 2000, you need to 
install the Windows 2000 drivers. 

Please note: 
♦ Administrative privileges are required for installation. 
♦ Before installing software, check the ViewCast support website or 

the ftp site for the any driver update releases subsequent to the 
software shipped on your CD. For the ViewCast support website, 
go to http://www.ospreyvideo.com/ > Downloads > Software 
and Drivers.  Select the operating system and card type. To reach 
the ViewCast.com ftp site, go to 
ftp://ftp.viewcast.com/pub/OSP-220/win2000/latest. It's 
a good idea to check these sites periodically for update releases. 

♦ The screens used to illustrate the installation steps may not be 
exactly what appear on your computer screen. In some cases, 
version numbers and other minor differences may appear in the 
installation you are running. 

Basics: Installing From CD 

Basics: Downloading and Installing Updated Drivers 

Canceling Out of Found New Hardware Wizard 

Three Install Scenarios 

Scenario 1: Osprey Card(s) not Physically Installed in the PC 

Scenario 2: Osprey Card(s) Physically Installed, but Osprey Software 
not Installed 

Scenario 3: Osprey Card(s) Physically Installed, and Previous Osprey 
Software Installed 

Installing Ligos Technology’s Indeo 

Testing the Installation for Windows 2000 

Uninstalling the Software 

http://www.ospreyvideo.com/
ftp://ftp.viewcast.com/pub/OSP-220/win2000/latest
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Basics: Installing From CD 

If necessary, follow the directions in Chapter 2 - Osprey-220 Hardware to install 
the Osprey card. This software installation procedure works properly only if the card 
is already installed. 

Installing from CD-ROM:   

1. Turn on the machine and start Windows 2000. 
2. Cancel out of the Found New Hardware wizard. 
3. If you are updating from a previous version of the driver, it is not necessary to 

uninstall the old driver before installing the new driver, unless the old driver is 
earlier than version 1.41. 

4. Insert the Osprey-220 Driver CD into your CDROM drive. The installation 
instructions assume this is the (D:) drive. Substitute the proper drive as it is 
configured on your system, if necessary. 

5. Run the installation program 
a. Click the Start button 

b. Click Run 
c. Enter D:\Win2000\Setup in the dialog box 
d. Click OK 

6. The installation program steps are self-explanatory for many users. If you need 
additional information, please refer to the section entitled Scenario 2: Card(s) 
Physically Installed, but Osprey Software not Installed. 

7. The driver and demo program are ready for use as soon as the installation 
program completes and you have rebooted the system. We suggest that you 
test the driver immediately. Please refer to Testing the Installation for 
Windows 2000. 

Basics: Downloading and Installing 
Updated Drivers 

To download and install the updated drivers:   

1. The latest software drivers for Osprey-220 Capture Cards are available via FTP 
(file transfer protocol) at the following locations: 
ftp://ftp.viewcast.com/pub/OSP-220/win2000/latest 

The same driver is used for the Osprey-200/210/220, so these links point to 
the same download file. There are also links to the drivers from our web site at 
http://www.ospreyvideo.com/. 

2. It is not necessary to uninstall your existing Osprey-220 driver before installing 
a newer version of the driver.  

ftp://ftp.viewcast.com/pub/OSP-220/win2000/latest
http://www.ospreyvideo.com/
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Note: If the existing version of the drivers is earlier than 1.41, you must 
uninstall the drivers. Follow the instructions in Uninstalling the 
Software and restart your computer before beginning the new install 
procedure. 

3. Use your web browser, such as Microsoft Internet Explorer or Netscape 
Navigator, to find our FTP site and download the file. Type the FTP address 
shown above into the address box at the top of your browser window. You may 
find it simpler to type just the first part of the address - 
ftp://ftp.viewcast.com - and then click on the list of directories that appear 
until you reach the win2000/latest location. Refer to your browser’s help files 
for more specific and detailed assistance. 

4. Download the web package file in win2000/latest to your hard disk. 
5. The Found New Hardware wizard will appear detecting each Osprey-220 card in 

the computer. Follow the directions in Canceling the Found New Hardware 
Wizard at each prompt. 

6. Run the web package program: 
e. Click the Start button. 

f. Click Run. 
g. Enter <pathname> in the dialog box, where <pathname> is the location 

and name of the file that you have downloaded. 

h. Click OK. 
i. The program prompts for a temporary location for unpacking the install 

files. 
See Scenario 2: Osprey Card(s) Physically Installed, but Osprey Software 
Not Installed for a full description of the Installation Program steps. 

 

These files are not automatically deleted after setup has run. This feature 
exists to offer the option of performing the manual Plug and Play install 
later. If you want to conserve disk space, make a note of where these 
files are being unpacked, and delete them after the install. 
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Canceling Out of the Found New Hardware 
Wizard 

When installing an updated Osprey-220 driver, first uninstall the existing driver and 
reboot the computer. The Found New Hardware wizard runs after restarting the 
computer. To cancel out the Found New Hardware wizard: 

To cancel out of the Found New Hardware wizard:   

The Digital Signature Not Found window displays for the Osprey-220 video 
capture device. 

 

1. Click No. 
The Completing Found New Hardware wizard window displays. 
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2. Click Finish. 
The Digital Signature Not Found window displays for the Osprey-220 audio 
capture device. 

 

3. Click No. 
The Completing Found New Hardware wizard window displays. 

 

4. Click Finish.  
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Three Install Scenarios 

There are three installation scenarios that might apply: 

♦ Scenario 1: Osprey Card(s) not Physically Installed in the PC 
♦ Scenario 2: Osprey Card(s) Physically Installed, but Osprey Software 

not Installed 
♦ Scenario 3: Osprey Card(s) Physically Installed, and Previous Osprey 

Software Installed 
In all cases, the most efficient and complete installation method is to run the 
setup.exe program on the product CD or in the web package that you downloaded. 
The setup program automates the Plug and Play steps required to install the drivers 
and ensures that they are performed correctly. It also installs the bundled applets 
and User's Guide. If you have multiple Osprey capture cards in the system, it 
configures all of the boards at the same time. 

 

You can skip the detailed instructions if you are upgrading from one 
Osprey driver version to another. Just run the setup.exe file to install all 
the updated components. 

Scenario 1: Osprey Card(s) not Physically Installed in the PC   

This Pre-install Scenario is the method that we recommend if you are installing an 
Osprey card for the first time on a system and the Osprey software has not yet been 
installed. After the install is run and as soon as an Osprey card is installed in the PC, 
the card is detected and its drivers are started automatically. 

To preinstall the Osprey drivers:  

1. Using Windows NT Explorer, locate and access the CD-ROM drive containing the 
Osprey Installation CD-ROM. 

2. Navigate to the WIN2000 directory. 
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3. Double-click SETUP.EXE. 
The Osprey Multimedia Capture Driver window displays. 

 

4. Click Next. 

The Information window displays. 
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5. Click Next. 
The Software License Agreement window displays. 

 

6. Click Yes to accept the End User Software Agreement.  If you do not wish to 
accept the agreement, click No to terminate the installation routine. 
The Select Components window displays. 
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7. To set this default, select the video signal standard used in your country and 
click Next. See Video Standard for more information about signal formats. 

The Choose Destination Location window displays. 

 

8. If you wish to change the destination location for the files, click Browse. Click 
Next. 
The Select Program Folder window displays. 
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9. Click Next. If you wish to change the program folder, type the new name in the 
Program Folders field. 

The Start Copying Files window displays. 

 

10. Click Next. 
The Ligos® Indeo® Information window displays. 

 

11. Click Next. If there are any settings to be changed prior to installation, click 
Back to return to the previous windows. 

A question dialog window displays. 
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12. Click Yes to continue installation. 
The Digital Signature Not Found window displays. 

 

 

Windows 2000 recognizes the audio and video portions of the Osprey 
cards as separate items.  The audio device is also present on Osprey-100 
and Osprey-101 cards containing extra video or power connectors in place 
of audio connectors. 

13. Click Yes to continue installation. 
The Digital Signature Not Found window displays. 

 

14. Click Yes to continue the installation process. 

The Osprey Technologies Special Offers Shortcut window displays. 
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15. If you would … then … 

 like a shortcut installed on 
your desktop,  

click Yes. 
A shortcut is created on the desktop. 

 not like a shortcut installed 
on your desktop,  

click No.  A Special Offers link is also available 
on the Programs menu. 

An information window displays. 

 

16. Click OK to continue the installation. 
The Product Registration window displays. 

 

17. If you would … then … 

 like to register your Osprey 
Multimedia Capture card,  

click Yes. 
A browser window opens. 

 not like to register your 
Osprey Multimedia Capture 
card,  

click No.  A product registration link is also 
available on the Programs menu or on the 
Osprey Video web site 
(http://www.ospreyvideo.com/) 

The Setup Complete window displays. 

 

http://www.ospreyvideo.com/
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18. If you are … then … 

 installing the Osprey card 
at this time,  

select Yes and proceed to step 19. 

 not installing the Osprey 
card at this time,  

select No and proceed to step 19. 

19. Click Finish. 

 

When you start your computer after installing the Osprey hardware, the 
Found New Hardware Wizard runs upon detecting new hardware. 

After restarting the computer, the Digital Signature Not Found window displays 
for the Osprey-220 Video Capture Device. 

 

20. Click Yes. 

The Files Needed window displays. 

 

21. Click Browse. 

22. Navigate to the \WinNT\System32\drivers directory. 
23. Click Open. 
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24. Click OK. 
The Digital Signature Not Found window displays for the Osprey audio capture 
device. 

 

25. Click Yes to continue the installation. 
The Files Needed window displays. 

 

26. Click Browse. 
27. Navigate to the \WinNT\System32\drivers directory. 
28. Click Open. 

29. Click OK. 
The Completing Found New Hardware wizard window displays. 
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30. Click Finish.  

 

You must restart your computer to complete the installation.  Do not 
attempt to use your Osprey card until after restarting the system. 

Scenario 2: Osprey Card(s) Physically Installed, but Osprey 
Software not Installed 

In this case you have two options, running the installation program or using the New 
Hardware Found Wizard, which is not recommended.  Using the Hardware Found 
Wizard is particularly inconvenient if you are installing multiple cards at once, since 
each card has to be set up separately. This process installs only the driver and is 
useful only for updating the driver component. Furthermore, to get the sample 
applications and other required items, you must still run the setup.exe program 

The manual recommends running the Osprey Installation Program and will only give 
instructions for installation via that method.  If the user chooses to use the Hardware 
Found Wizard, they do so at their own risk. 

Run the Installation Program 

When windows 2000 is started for the first time after the Osprey card is installed, 
the Found New Hardware wizard displays one or more times. Cancel out of these 
wizards. After Windows 2000 has finished starting, do the following: 

To install the Osprey drivers:  

1. Using Windows NT Explorer, locate and access the CD-ROM drive containing the 
Osprey Installation CD-ROM. 

2. Navigate to the WIN2000 directory. 
3. Double-click SETUP.EXE. 

The Osprey Multimedia Capture Driver window displays. 
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4. Click Next. 
The Information window displays. 

 

5. Click Next. 

The Software License Agreement window displays. 
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6. Click Yes to accept the End User Software Agreement.  If you do not wish to 
accept the agreement, click No to terminate the installation routine. 

The Select Components window displays. 

 

7. To set this default, select the video signal standard used in your country and 
click Next. See Video Standard for more information about signal formats. 
The Choose Destination Location window displays. 
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8. If you wish to change the destination location for the files, click Browse. Click 
Next. 

The Select Program Folder window displays. 

 

9. Click Next. If you wish to change the program folder, type the new name in the 
Program Folders field. 
The Start Copying Files window displays. 
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10. Click Next. 
The Ligos® Indeo® Information window displays. 

 

11. Click Next. If there are any settings to be changed prior to installation, click 
Back to return to the previous windows. 
The Digital Signature Not Found window displays. 

 

 

Windows 2000 recognizes the audio and video portions of the Osprey 
cards as separate items.  The audio device is also present on Osprey-100 
and Osprey-101 cards containing extra video or power connectors in place 
of audio connectors. 
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12. Click Yes to continue installation. 
The Digital Signature Not Found window displays. 

 

13. Click Yes to continue the installation process. 
The Osprey Technologies Special Offers Shortcut window displays. 

 

14. If you would … then … 

 like a shortcut installed on 
your desktop,  

click Yes. 
A shortcut is created on the desktop. 

 not like a shortcut installed 
on your desktop,  

click No.  A Special Offers link is also available 
on the Programs menu. 

An information window displays. 

 

15. Click OK to continue the installation. 

The Product Registration window displays. 
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16. If you would … then … 

 like to register your Osprey 
Multimedia Capture card,  

click Yes. 
A browser window opens. 

 not like to register your 
Osprey Multimedia Capture 
card,  

click No.  A product registration link is also 
available on the Programs menu or on the 
Osprey Video web site 
(http://www.ospreyvideo.com/) 

The Setup Complete window displays. 

 

17. If you are … then … 

 installing the Osprey card 
at this time,  

select Yes and proceed to step 19. 

 not installing the Osprey 
card at this time,  

select No and proceed to step 19. 

18. Click Finish. 

 

You must restart your computer to complete the installation.  Do not 
attempt to use your Osprey card until after restarting the system. 

http://www.ospreyvideo.com/
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Scenario 3:  Osprey Card(s) Physically Installed, and 
Previous Osprey Software Installed  

This scenario is for the case when the Osprey card is physically installed in the PC 
and there is a previous installation of the Osprey drivers. These methods work for 
upgrades either from an old Osprey Windows 2000 driver to a newer one, or – if you 
have upgraded the operating system – from a Windows NT 4.0 driver to a Windows 
2000 driver. 

Under this scenario you have two options. With both options, it is not necessary to 
uninstall the old driver before installing the new driver. 

Option A: Run the Installation Program (Recommended) 

Option B: Use the Device Manager (Normally not Recommended) 

Installing Ligos Technology’s Indeo 

Option A: Run the Installation Program (Recommended) 

To install the Osprey drivers:  

1. Using Windows NT Explorer, locate and access the CD-ROM drive containing the 
Osprey Installation CD-ROM. 

2. Navigate to the WIN2000 directory. 
3. Double-click SETUP.EXE. 

The Osprey Multimedia Capture Driver window displays. 
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4. Click Next. 
The Information window displays. 

 

5. Click Next. 

The Software License Agreement window displays. 
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6. Click Yes to accept the End User Software Agreement.  If you do not wish to 
accept the agreement, click No to terminate the installation routine. 

The Select Components window displays. 

 

7. To set this default, select the video signal standard used in your country and 
click Next. See Video Standard for more information about signal formats. 
The Choose Destination Location window displays. 
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8. If you wish to change the destination location for the files, click Browse. Click 
Next. 

The Select Program Folder window displays. 

 

9. Click Next. If you wish to change the program folder, type the new name in the 
Program Folders field. 
The Start Copying Files window displays. 
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10. Click Next. 
The Ligos® Indeo® Information window displays. 

 

11. Click Next. If there are any settings to be changed prior to installation, click 
Back to return to the previous windows. 
A question dialog window displays. 

 

12. Click Yes to continue installation. 

The Digital Signature Not Found window displays. 

 

 

Windows 2000 recognizes the audio and video portions of the Osprey 
cards as separate items.  The audio device is also present on Osprey-100 
and Osprey-101 cards containing extra video or power connectors in place 
of audio connectors. 
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13. Click Yes to continue installation. 
The Digital Signature Not Found window displays. 

 

14. Click Yes to continue the installation process. 
The Osprey Technologies Special Offers Shortcut window displays. 

 

15. If you would … then … 

 like a shortcut installed on 
your desktop,  

click Yes. 
A shortcut is created on the desktop. 

 not like a shortcut installed 
on your desktop,  

click No.  A Special Offers link is also available 
on the Programs menu. 

An information window displays. 

 

16. Click OK to continue the installation. 

The Product Registration window displays. 

 



Chapter 3 - Installing the Software - Windows 2000 

54 – Osprey-210, Osprey-220 and Osprey-230 User's Guide ViewCast Corporation 

17. If you would … then … 

 like to register your Osprey 
Multimedia Capture card,  

click Yes. 
A browser window opens. 

 not like to register your 
Osprey Multimedia Capture 
card,  

click No.  A product registration link is also 
available on the Programs menu or on the 
Osprey Video web site 
(http://www.ospreyvideo.com/) 

The Setup Complete window displays. 

 

18. If you are … then … 

 installing the Osprey card 
at this time,  

select Yes and proceed to step 19. 

 not installing the Osprey 
card at this time,  

select No and proceed to step 19. 

19. Click Finish. 

20. Click Finish to restart the computer. 

 

You must restart your computer to complete the installation.  Do not 
attempt to use your Osprey card until after restarting the system. 

http://www.ospreyvideo.com/
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After restarting the computer, the Digital Signature Not Found window displays 
for the Osprey-220 audio capture device. 

 

21. Click No. 
The Completing Found New Hardware wizard window displays. 

 

22. Click Finish.  

 

The Osprey card does not need to be installed at this time. You also do 
not need to restart the computer again at this time. 

When the card is installed, Windows 2000 detects the card and 
automatically activates the driver. 
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Option B: Use the Device Manager (Normally not 
Recommended) 

This method will only install the drivers. It will not update the bundled applications, 
User's Guide, or Start Menu. It is sometimes useful for repairing an installation 
where the driver seems to be incorrectly or incompletely installed. 

 

Note to Osprey-200 users: To completely update your audio and video 
drivers, you have to repeat steps 7 through 20 twice - once to update the 
audio driver, once to update the video driver. You can install the drivers 
in either order - either the audio driver first, or the audio driver first. The 
example here assumes that you are updating the audio driver. With 
video-only cards - Osprey-50, -100, and -101 - you need to update the 
video driver only. 

To update the drivers using the Device Manager:  

1. Click Start and select Settings. 

2. Select Control Panel. 
3. Double-click System. 

The System Properties window displays. 
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4. Select the Hardware tab. 
The Hardware tab displays. 

 

5. Click Device Manager. 
The Device Manager window displays. 

6. Double click the Sound, video and game controllers entry. 

The Sound, Video and Game Controllers entry expands. 
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7. If you are updating the audio driver, double-click Osprey Audio Capture 
Device. If you are updating the video driver, double-click Osprey Audio 
Capture Device. 
If you have two or more Osprey Capture Cards in the system there will be 
separate entries for each video device and each audio device. Click on any one 
of the devices to update the driver for all of them. 

A Properties dialog displays. 

 

8. Click the Driver tab. 
The Driver tab displays. 
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9. Click Update Driver. 
The Upgrade Device Driver Wizard displays. 

 

10. Click Next. 

The Upgrade Device Driver Wizard displays. 
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11. Click to select the Display a list of the known drivers for this device ... radio 
button. 

12. Click Next. 
The Upgrade Device Driver Wizard displays. 

 

13. Click Have Disk. 
The Install From Disk window displays. 

 

14. Click Browse to locate the O100DRV.INF file. 
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15. Click OK to return to the Upgrade Device Driver Wizard. 
The Upgrade Device Driver Wizard displays. 

 

16. Select the device to update: 

♦ If you are updating the Osprey-200 audio function, select Osprey Audio 
Capture Device. 

♦ If you are updating the video function of any Osprey capture card, select 
Osprey Video Capture Device. 

♦ The newer Osprey-50, -100, and -101 video-only cards have an on-chip 
audio interface that, while not usable, is nonetheless detected by Plug and 
Play. Install the Osprey Function 1 Placeholder to satisfy Plug and Play 
that the unused audio function is "installed" without copying unnecessary 
audio files to the system directory. 

17. Click Next. 
The Upgrade Device Driver Wizard displays. 

 

 

An Update Driver Warning may display. If you have followed the 
instructions carefully, this is a safe operation. 
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18. Click Next. 
The Digital Signature Not Found window displays. 

 

19. Click Yes to continue the installation. 
20. Click Finish to complete the wizard. 

21. In a moment the Device Manager screen updates. 
If you have multiple boards installed in the system, then you normally need to 
update the audio driver and the video driver for just one device. You will have 
multiple capture devices to choose from, and you can pick any one of them. 
If, however, one or more Multimedia Video Controller or Multimedia 
Controller devices appear in the Device Manager list (as shown in step 6) that 
correspond to Osprey cards, then these will need to be individually installed, 
one device at a time. These devices will have a exclamation mark on a yellow 
field as part of their icon - indicating that they are not properly installed. They 
could be listed either under Sound, video and game controllers or under 
Other devices. Upgrade a Multimedia Video Controller as an Osprey 
Video Capture Device, and a Multimedia Controller as an Osprey Audio 
Capture Device or Osprey Function 1 Placeholder. Double click on each of 
these items and follow steps 7 through 20. When you are asked to specify the 
hardware type, select Sound, video and game controllers. 

22. Repeat steps 7 through 20 for the remaining capture device(s). For example, if 
you just upgraded the audio capture device, repeat these steps for the video 
capture device. 

 

You have to restart the system before you can use the updated drivers. 
There is one exception: If you have a single video-only card - a single 
Osprey-50, -100, or -101 - you do not have to restart, and can use the 
updated drivers immediately. 
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Installing Ligos Technology's Indeo 

 

Ligos Technology’s Indeo Video package contains software codecs and compressors 
that enhance the usefulness of the card. You need to install this package if you want 
to use the three YUV color formats 

♦ 4:2:2 packed 
♦ YUV12 
♦ YVU9 

There is also a software compressor which creates compressed video files in real 
time at full capture speed. Indeo is recommended if you will be using Microsoft 
Windows Media Encoder. This software is described in more detail in Chapter 7. 

To install Ligos Technology’s Indeo Video software:  

1. Click Yes to install Indeo Video software. Click No if you do not wish to install 
the software at this time.  
The Indeo® Installation window displays. 

 



Chapter 3 - Installing the Software - Windows 2000 

64 – Osprey-210, Osprey-220 and Osprey-230 User's Guide ViewCast Corporation 

2. Click Next to continue. 
The Software License Agreement window displays. 

 

3. Click Yes. 
The Choose Destination Location window displays. 
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4. Click Next. If you wish to change the destination location for the files, click 
Browse. 

The Setup Type window displays. 

 

5. Select Developer and click Next. 

A question window displays. 

 

6. If you ... then … 

 want to backup your 
system files, 

click Yes and proceed to step 6. 
The Choose Destination window displays. 

 do not want to backup your 
system files, 

click No and proceed to step 7. 

7. Type the path or click Browse to locate the path in which you want to save the 
backup of your system files. 
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8. Click Next. 
The Start Copying Files window displays. 

 

9. Click Next to proceed with the installation. Click Back to make any changes 
prior to the installation. 

After the files are copied to the system, the Indeo Software Setup Is Now 
Complete window displays. 

 

10. Click Finish.  
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Testing the Installation for Windows 2000  

1. Verify that the hardware installation is complete according to the directions in 
Chapter 2- Osprey-210, Osprey-220 and Osprey-230 Hardware. 

2. Connect a video signal source to one of the Osprey-220 connectors 
(Composite/S-video). 

3. Open the Osprey MultiMedia Capture group in the Start menu. 
4. Click the VidCap32 icon. Refer to Chapter 8 - VidCap32, Amcap, Control 

Panel, Cropping & Scaling and Indeo for more information on this 
application. 

5. If your input is composite video, the screen displays a still video frame from the 
Osprey-220 board. Click the Overlay button. The screen should display moving 
video frames. If your input choice is not composite video, select the Video 
Source option under the Options menu. This brings up the Osprey-220’s video 
capture driver configuration box where you can select your video input. 

6. If the video area does not contain video, it could be for one of the following 
reasons: 
a. The driver is looking for video on the wrong input connector. You can either 

move the video cable to another connector or reconfigure the driver using 
its Control Dialog. Refer to Chapter 6 - Osprey-210, Osprey-220 and 
Osprey-230 Video Control Dialog. 

b. The video source is not turned on or activated. 
7. If the video area is scrambled or has bad color, the signal format of your video 

source may be different from the signal format selected in the driver software. 
Since the driver defaults to NTSC-M signal format, users of PAL equipment 
always need to change the driver’s signal format the first time they run the 
driver. Refer to Chapter 6 - Osprey-210, Osprey-220 and Osprey-230 
Video Control Dialog for more information. 

Uninstalling the Software 

To remove the Osprey driver from your system:  

1. Open the Control Panel. 
2. Double-click Add/Remove Programs. 
3. Click to select Change or Remove Programs. 

4. Highlight the Osprey MultiMedia Capture Driver entry. 
5. Click Change/Remove in the Osprey entry. 

The uninstall program begins. 

6. Click Yes to proceed. 
7. Click OK when the process is complete. 
8. Please reboot your computer to finish removing the driver. 
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Chapter 4 – Installing the Software – 
Windows XP 

The Osprey Capture Card products contains a single CD for Windows 2000, Windows 
XP, Windows NT 4.0 and Windows 95/98. The Windows 95/98 driver is an entirely 
separate driver that is not covered by this User's Guide. 

After you’ve installed the software, you can test the card and software by running 
the included application program, VidCap32. 

Basics: Installing From CD 

Basics:  Downloading and Installing Updated Drivers 

Two Installation Scenarios 

Scenario 1:  Osprey Card(s) not Physically Installed in the PC 

Scenario 2:  Osprey Card(s) Physically Installed, but Osprey Software 
not Installed 

Testing the Installation 

Uninstalling the Software 

Basics: Installing From CD  

1. Insert the Osprey CD into your CDROM drive. The installation instructions 
assume this is the "D:" drive. Substitute the proper drive name as it appears on 
your system where appropriate. 

2. Run the installation program: 
a. Click the Start button. 
b. Click Run.... 
c. Enter d:\winxp\setup.exe in the dialog box. 

d. Click OK.  

Basics:  Downloading and Installing 
Updated Drivers  

1. The latest software drivers for Osprey Multimedia Capture Cards are available 
via FTP (file transfer protocol), at the following locations: 

ftp://ftp.viewcast.com/pub/OSP-100/winXP/latest 

ftp://ftp.viewcast.com/pub/OSP-200/winXP/latest 

ftp://ftp.viewcast.com/pub/OSP-100/winXP/latest
ftp://ftp.viewcast.com/pub/OSP-200/winXP/latest
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The same driver is used for the Osprey-50, Osprey-100, Osprey-101 and Osprey-
200, so these links point to the same download file. 

There are also links to the drivers from our web site, 
http://www.ospreyvideo.com/ 

2. Use your web browser, such as Microsoft Internet Explorer or Netscape 
Navigator, to find our FTP site and download the file. Type the FTP address 
shown above into the address box at the top of your browser window. You may 
find it simpler to type just the first part of the address - 
ftp://ftp.viewcast.com - and then click on the list of directories that display 
until you have reached the ...winXP/latest location. Refer to your browser’s 
help files for more specific and detailed assistance. 

3. Download the web package file in ...winXP/latest to your hard disk. 
4. Run the web package program: 

a. Click the Start button. 
b. Click Run.... 
c. Enter <pathname> in the dialog box, where <pathname> is the location 

and name of the file that you have downloaded. 

d. Click OK. 
e. The program prompts you for a temporary location to unpack the install files 

to. 

 

These files are not be automatically deleted after setup has run. This is so 
that you can perform the manual Plug and Play install if you want to. So 
make a note of where these files are located, and delete them after the 
install if you want to conserve disk space. 

Two Installation Scenarios 

There are three main situations that might apply to you: 

Scenario 1: Osprey Card(s) not Physically Installed in the PC 

Scenario 2: Osprey Card(s) Physically Installed, but Osprey Software not 
Installed 

In all cases, the most efficient and complete installation method is to run the 
setup.exe program on the product CD or in the web package that you downloaded. 
The setup program automates the Plug and Play steps required to install the drivers 
and ensures that they are performed correctly. It also installs the bundled applets 
and User's Guide. If you have multiple Osprey capture cards in the system it 
configures all of the boards at the same time. 

 

You can skip the detailed instructions if you are upgrading from one 
Osprey driver version to another. Just run the setup.exe file, and all the 
updated components will be installed. 

http://www.ospreyvideo.com/
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Scenario 1:  Osprey Card(s) not Physically Installed in the 
PC  

This is the method that we recommend if you are installing an Osprey card for the 
first time on a system, and the Osprey software has not yet been installed. This 
scenario is called the "Preinstall Scenario". After the install is run, as soon as an 
Osprey card is installed in the PC, it is detected and its drivers are started 
automatically. 

To preinstall the Osprey drivers:  

1. Using Windows Explorer, locate and access the CD-ROM drive containing the 
Osprey Installation CD-ROM. 

2. Navigate to the WINXP directory. 
3. Double-click SETUP.EXE. 

The Osprey Multimedia Capture Driver window displays. 
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4. Click Next. 
The Software License Agreement window displays. 

 

5. Click Yes to accept the End User Software Agreement.  If you do not wish to 
accept the agreement, click No to terminate the installation routine. 
The Select Components window displays. 
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6. Click the radio button to select the default signal format.  See Video Standard 
for more information about signal formats. 

7. Click Next. 
The Information window displays. 

 

8. Click Next. 

The Choose Destination Location window displays. 

 



Chapter 4 – Installing the Software – Windows XP 

74 – Osprey-210, Osprey-220 and Osprey-230 User's Guide ViewCast Corporation 

9. Click Next. If you wish to change the program folder, type the new name in the 
Program Folders field. 

The Select Program Folder window displays. 

 

10. Click Next. 
The Start Copying Files window displays. 
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11. Click Next. 
The Ligos Indeo Information window displays. 

 

12. Click Next. 
The Pre-installation question window displays. 

 

13. Click Yes. 
The Hardware Installation window displays. 

 

14. Click Continue Anyway. 
The files begin copying to the computer. 
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The ViewCast Corporation/Osprey Video Division Special Offers Shortcut 
window displays. 

 

15. If you would … then … 

 like a shortcut installed on 
your desktop,  

click Yes. 
A shortcut is created on the desktop. 

 not like a shortcut installed 
on your desktop,  

click No.  A Special Offers link is also available 
on the Programs menu. 

An information window displays. 

 

16. Click OK to continue the installation. 
17. Click Next. 

The Product Registration window displays. 
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18. If you would … then … 

 like to register your Osprey 
Multimedia Capture card,  

click Yes. 
A browser window opens. 

 not like to register your 
Osprey Multimedia Capture 
card,  

click No.  A product registration link is also 
available on the Programs menu or on the 
Osprey Video web site 
(http://www.ospreyvideo.com/) 

The Setup Complete window displays. 

 

19. Click to select No. 
20. Click Finish. 

 

When you start your computer after physically installing the Osprey 
hardware, the Found New Hardware Wizard runs upon detecting new 
hardware. The sequence of windows are similar to that in Appendix H - 
Adding/Moving Boards in Windows 2000 and XP. 

Scenario 2:  Osprey Card(s) Physically Installed, but Osprey 
Software not Installed 

In this case you have two options: 

Option A: Run the Installation Program (Recommended) 

Option B: Use the New Hardware Found Wizard (Not Recommended) 

http://www.ospreyvideo.com/
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Option A: Run the Installation Program (Recommended) 

When Windows XP is first started for the first time after the Osprey card is installed, 
the New Hardware Found wizard displays one or more times. Cancel out of these 
wizards. After Windows XP has finished starting, perform the following steps. 

To install the Osprey drivers:  

1. Using Windows Explorer, locate and access the CD-ROM drive containing the 
Osprey Installation CD-ROM. 

2. Navigate to the WINXP directory. 
3. Double-click SETUP.EXE. 

The Osprey Multimedia Capture Driver window displays. 

 

4. Click Next. 
The Software License Agreement window displays. 
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5. Click Yes to accept the End User Software Agreement.  If you do not wish to 
accept the agreement, click No to terminate the installation routine. 

The Select Components window displays. 

 

6. Click the radio button to select the default signal format.  See Video Standard 
for more information about signal formats. 

7. Click Next. 
The Information window displays. 
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8. Click Next. 
The Choose Destination Location window displays. 

 

9. Click Next. If you wish to change the program folder, type the new name in the 
Program Folders field. 
The Select Program Folder window displays. 
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10. Click Next. 
The Start Copying Files window displays. 

 

11. Click Next. 
The Hardware Installation window displays. 

 

12. Click Continue Anyway. 
The Hardware Installation window displays. 
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13. Click Continue Anyway. 
The files begin copying to the computer. 

 

The ViewCast Corporation/Osprey Video Division Special Offers Shortcut 
window displays. 

 

14. If you would … then … 

 like a shortcut installed on 
your desktop,  

click Yes. 
A shortcut is created on the desktop. 

 not like a shortcut installed 
on your desktop,  

click No.  A Special Offers link is also available 
on the Programs menu. 

An information window displays. 

 

15. Click OK to continue the installation. 

The Ligos Indeo Information window displays. 

 



 Chapter 4 – Installing the Software – Windows XP 

ViewCast Corporation Osprey-210, Osprey-220 and Osprey-230 User's Guide – 83 

16. Click Next. 
The Product Registration window displays. 

 

17. If you would … then … 

 like to register your Osprey 
Multimedia Capture card,  

click Yes. 
A browser window opens. 

 not like to register your 
Osprey Multimedia Capture 
card,  

click No.  A product registration link is also 
available on the Programs menu or on the 
Osprey Video web site 
(http://www.ospreyvideo.com/) 

The Setup Complete window displays. 

 

18. Click Finish to restart the computer. 

 

You must restart your computer to complete the installation.  Do not 
attempt to use your Osprey card until after restarting the system. 

http://www.ospreyvideo.com/
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Option B: Use the New Hardware Found Wizard (Not 
Recommended)  

This method is more complicated than Option A. It is particularly inconvenient if you 
are installing multiple cards at once, since each card has to be set up separately. 

When Windows XP starts, it detects the new card(s) and starts the Found New 
Hardware wizard. 

 

For all Osprey-100, 101, 200, 210 and 220 cards, the Wizard detects 
two logical devices for each card - a Multimedia Video Controller device 
and a Multimedia Controller or Osprey Function 1 Placeholder device. The 
Multimedia Video Controller is the video section of the Osprey video/audio 
capture device; the Multimedia Controller is the audio section; the Osprey 
Function 1 Placeholder is present on Osprey-100 and 101 cards, and is a 
method for telling Windows XP that this is a video-only device.  The audio 
logical device may be present on some Osprey-100 and Osprey-101 cards 
that have video or power connectors in place of the audio inputs. 

When the Found New Hardware Wizard detects a device: 

 

Please note the terminology in the Wizard.  It displays either Multimedia 
Video Controller or Multimedia Controller. 

The Found New Hardware Wizard first detects one of the following 3 devices: 

♦ Osprey Video Capture Device 
♦ Osprey Audio Capture Device 
♦ Osprey Function 1 Placeholder 

The Found New Hardware Wizard window displays. 
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1. Click to select Install from a list or specific location and click Next to 
continue. 

The Found New Hardware Wizard window displays. 

 

2. Click to select Search for the best driver in these locations.   

3. Click to select the checkbox Include this location in the search, and type in 
the drive letter of your CD-ROM drive followed by "\WinXP" to provide the 
location of the Windows XP driver on your distribution CD.  

4. Click Next to continue. 

The Please wait while the wizard searches... window displays briefly, and then 
is covered by the Hardware Installation window. 
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5. Click Continue Anyway. 
The Setting System Restore Point window displays briefly, and then is replaced 
by the Completing the Found New Hardware Wizard window. 

 

6. Click Finish.  

Next the Wizard finds and installs the audio portion of the device. 

The Found New Hardware Wizard window displays. 
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7. Click to select Install the software automatically and click Next to 
continue. 

The Hardware Installation window displays. 

 

8. Click Continue Anyway. 
The Completing the Found New Hardware Wizard window displays. 

 

9. Click Finish.   

 

If you are installing a single Osprey card, you do not need to restart the 
computer.  If you are installing more than one Osprey card, you are 
required to restart the computer. 

After completing the Found New Hardware Wizard, the applications for the Osprey 
driver must also be installed. To do this, navigate to the directory containing the 
Windows XP driver for your Osprey card, and run SETUP.EXE.  For detailed steps, 
please refer to Option A: Run the Installation Program (Recommended). 
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Testing the Installation  

1. Verify the hardware installation is complete, in accordance with the directions in 
Chapter 2. 

2. Connect a camera, VCR, or other video signal source to the Osprey card’s 
connectors. 

3. Open the Osprey Multimedia Capture group in the Start menu. 
4. Click the VidCap32 icon. 
5. Verify the screen displays a still video frame from the Osprey-100 board. Click 

the Preview or Overlay button. The screen should display moving video 
frames. 

6. If the video area is a plain blue field, it could be for one of the following 
reasons: 

f. The driver is looking for video on the wrong input connector. You can either 
move the video cable to another connector, or reconfigure the driver using 
its Control Dialog (refer to Chapter 6 - Osprey-210, Osprey-220 and 
Osprey-230 Video Control Dialog). 

g. The video source is not turned on or activated. 
7. If the video area is scrambled or has bad color, the signal format of your video 

source may be different from the signal format selected in the driver software. 
Since the driver defaults to NTSC-M signal format, users of PAL and SECAM 
equipment always need to change the driver’s signal format the first time they 
run the driver. Please see Video Standard in Chapter 6 - Osprey-210, 
Osprey-220 and Osprey-230 Video Control Dialog. 

Uninstalling the Software  

If you ever need to remove the Osprey driver from your system, proceed as follows: 

1. Open the Control Panel. 
2. Double-click Add/Remove Programs. 
3. Click to select Change or Remove Programs. 

4. Highlight the Osprey Multimedia Capture Driver entry. 
5. Click Change/Remove in the Osprey entry. 

The uninstall program begins. 

6. Click Yes to proceed. 

7. Click OK when the process is complete.  
8. Reboot your computer to complete the uninstall process. 
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Chapter 5 - Installing the Software - 
Windows NT 4.0 

The Osprey Capture Card products contains a single CD for Windows 2000 and 
Windows NT 4.0. 

 

The Osprey-210 and Osprey-220 cards are supported under Windows NT.  
The Osprey-230 card in not supported under Windows NT. 

After you’ve installed the software, you can test the card and software by running 
the included application program VidCap32. 

 

Please note: 

♦ Administrative privileges are required for installation. 
♦ Before installing software, check the ViewCast.com support 

website or the ftp site for the any driver update releases 
subsequent to the software shipped on your CD. For the 
ViewCast.com support website, go to 
http://www.ospreyvideo.com/ > Downloads > Software and 
Drivers.  Select the operating system and card type. To reach the 
ViewCast.com ftp site, go to ftp://ftp.viewcast.com/pub/OSP-
220/winnt/latest. It's a good idea to check these sites 
periodically for update releases. 

♦ The screens used to illustrate the installation steps may not be 
exactly what appear on your computer screen. In some cases, 
version numbers and other minor differences may appear in the 
installation you are running. 

♦ If you have not installed Microsoft's DirectXMedia package, it is 
required to run Windows Media Encoder 7. It is included on your 
Osprey MultiMedia CD-ROM. 

If you already have the Osprey driver software installed on your system 
and are updating it, you do not have to remove the old version before 
installing the new version. The installation program removes or replaces 
any files or registry settings that are outdated. 

Installing from CD 

Downloading and Installing Updated Drivers 

Setup Program: Details 

Installing Ligos Technology’s Indeo 

Testing the Installation for Windows NT 

Uninstalling the Software 

http://www.ospreyvideo.com/
ftp://ftp.viewcast.com/pub/OSP-220/winnt/latest
ftp://ftp.viewcast.com/pub/OSP-220/winnt/latest
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Installing from CD  

If necessary, follow the directions in Chapter 2- Osprey-210, Osprey-220 and 
Osprey-230 Hardware to install the Osprey card. This software installation 
procedure works properly only if the card is already installed. 

1. Turn on the machine and start Windows NT. 
2. If you are updating from a previous version of the driver, it is not necessary to 

uninstall the old driver before installing the new driver, unless the old driver is 
earlier than version 1.41. 

3. Insert the Osprey-210, Osprey-220 and Osprey-230 Driver CD into your 
CDROM drive. The installation instructions assume this is the (D:) drive. 
Substitute the proper drive as it is configured on your system, if necessary. 

4. Run the installation program 

a. Click the Start button. 
b. Click Run. 
c. Enter D:\WinNT\Setup in the dialog box. 

d. Click OK. 
5. The installation program steps are self-explanatory for many users. If you need 

additional information, please refer to the section entitled Setup Program: 
Details. 

6. The driver and demo program are ready for use as soon as the installation 
program completes and you have rebooted the system. We suggest you test 
the driver immediately. Refer to the section entitled Testing the Installation 
for Windows NT. 

Downloading and Installing Updated 
Drivers  

1. Install the Osprey board in the PC if you have not already done so, turn on the 
machine and start Windows NT. 

2. The latest software drivers for Osprey-210, Osprey-220 and Osprey-230 
Capture Cards are available via FTP (file transfer protocol) at the following 
location: 
ftp://ftp.viewcast.com/pub/OSP-220/winnt/latest 

There are also links to the drivers from our web site at 
http://www.ospreyvideo.com/. 

3. Use your web browser, such as Microsoft Internet Explorer or Netscape 
Navigator, to find our FTP site and download the file. Type the FTP address 
shown above into the address box at the top of your browser window. You may 
find it simpler to type just the first part of the address -  
ftp://ftp.viewcast.com/ - and then click on the list of directories that appear 
until you have reached the winnt/latest location. Refer to your browser’s help 
files for more specific and detailed assistance. 

ftp://ftp.viewcast.com/pub/OSP-220/winnt/latest
http://www.viewcast.com/
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4. Download the web package in winnt/latest to your hard drive. 
5. It is not necessary to uninstall your existing Osprey-210, Osprey-220 and 

Osprey-230 driver before installing a newer version of the driver.   

 

Note: If the existing version of the drivers is earlier than 1.41, you must 
uninstall the drivers. Follow the instructions in Uninstalling the 
Software and restart your computer before beginning the new install 
procedure. 

6. Run the web package program. 
a. Click the Start button 
b. Click Run 

c. Enter <pathname> in the dialog box, where <pathname> is the location 
and name of the file that you have downloaded 

d. Click OK 

7. The program prompts you for a temporary location in which to unpack the 
installation files and starts the setup program. The setup program guides you 
through the installation steps. For many users this process is self-explanatory. 
If you need additional information, please refer to the section entitled Setup 
Program: Details. 

 

The installation files are not automatically deleted after setup has run. If 
you want to conserve disk space, make a note of the temporary location 
where these files are being unpacked and delete them after the 
installation. 

8. You must restart the computer before the driver and sample applications will be 
ready for use. We recommend that you test the driver immediately after 
restarting your computer.  
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Setup Program: Details  

The setup program presents a sequence of windows and dialogs to guide you 
through the setup process. In general, click the Next > button to continue to the 
next screen. At any point you can click < Back to return to a previous screen or 
Cancel to exit the installation. 

The installation of the Osprey Multimedia Driver for Windows NT begins with a 
confirmation that the setup program is beginning. 

The Welcome window displays. 

 

1. Click Next. 

The Information window displays. 
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2. Click Next. 
The Software License Agreement window displays. 

 

3. Review this message and make sure that the licensing terms are acceptable. 
Click Yes to accept the agreement. If you do not wish to accept the agreement, 
click No to terminate the installation routine. 
The Setup Type window displays. 
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4. This window allows you to select the installation type. If you have any 
combination of Osprey cards which includes at least one Osprey-200 card, 
choose the Osprey-200/210/220 setup. If you have any combination of Osprey-
100, Osprey-50CPI and Osprey-101 cards, choose the Osprey-100 setup type. 
Choose the Custom setup if you want more control over the installation. You 
will then be prompted to select which components to install. 

The Osprey-100 and Osprey-200 setup types automatically install the third-
party applications Ligos Indeo and DirectX Media. The option of not installing 
these third-party applications comes only with the Custom setup type. Make 
your setup type selection and click Next. 

The Select Components window displays. 

 

5. This window displays a list of choices for the default video signal format used in 
your country.  Select the Video signal standard you wish to use and click Next. 
For more information about video signal formats, see Video Standard. 

The Choose Destination Location window displays. 
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6. The destination location is the folder where `VidCap32 (the demo applet), 
ReadMe, and other auxiliary files are located. (The core video capture driver 
files are located in Windows NT system directories regardless of the destination 
location chosen here.) The default location, in the Program Files folder, should 
be appropriate for most systems. If you install the Windows 2000, Windows XP, 
Windows NT and Windows 95/98 versions, you can place them in the same 
directory, and you can save a small amount of disk space by doing so. Click the 
Browse button near the bottom of the dialog if you want to change the 
location. 
The Select Program Folder window displays. 

 

7. The setup program suggests placing the Osprey icons in a new program folder 
entitled “Osprey MultiMedia Capture.” You can change this name by editing the 
Program Folders field, or you can add the icons to an existing folder by 
highlighting it in the Existing Folders window. Click Next to continue. 

The Start Copying Files window displays. 
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8. Click Next. 
The Ligos® Indeo® Information window displays. 

 

9. Click Next. 

The DirectX® Information window displays. 

 

10. Click Back to modify the directory and program folder destinations or click 
Next to continue. The installation program copies the files to their destinations, 
sets up the Osprey driver registry entries, and starts the driver. 

A question dialog window displays. 
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11. If you would … then … 

 like a shortcut installed on 
your desktop,  

click Yes. 
A shortcut is created on the desktop. 

 not like a shortcut installed 
on your desktop,  

click No.  A Special Offers link is also available 
on the Programs menu. 

An information window displays. 

 

12. Click OK to continue the installation. 
If another kind of video capture driver is already installed on your system, 
another question dialog window displays. 

 

13. Click Yes to make the Osprey driver your primary video capture driver, unless 
you have a particular reason for doing otherwise. Refer to Appendix D - Using 
the Osprey Video Capture Driver with Other Drivers for more detailed 
information about this message. 
If another kind of audio capture device such as a soundcard is already installed 
on your system, a message similar to the one above displays asking, “Do you 
want to make this your primary audio capture driver?” 

 

14. Click Yes to use the Osprey-210, Osprey-220 and Osprey-230 as the primary 
audio capture device. 
The Product Registration window displays. 
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15. If you would … then … 

 like to register your Osprey 
Multimedia Capture card,  

click Yes. 
A browser window opens. 

 not like to register your 
Osprey Multimedia Capture 
card,  

click No.  A product registration link is also 
available on the Programs menu or on the 
Osprey Video web site 
(http://www.ospreyvideo.com/) 

The Setup Complete window displays. 

 

16. Click Finish. 

 

If you have an Osprey-100, -101, or -50 card, the driver is ready to test 
and use. 

 

If you have an Osprey-200 card, you must restart Windows NT in order to 
use the audio capture feature. Normally, the installation program 
recommends a restart if one is needed, based on the type of card you 
have present. 

However, if you are updating from driver version 1.33 or earlier to driver 
version 1.35 or later, you will have to restart Windows NT after the 
installation. Normally the installation program will detect this condition 
and recommend the restart if it is needed. 

http://www.ospreyvideo.com/
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Installing Ligos Technology’s Indeo 

This procedure is the same regardless of the computer's operating system. See 
Installating Ligos Technology’s Indeo in Chapter 3. For detailed instructions, 
please refer to the Ligos Technology’s Indeo section in Chapter 7. 

Testing the Installation for Windows NT  

1. Verify that the hardware installation is complete according to the directions in 
Chapter 2- Osprey-210, Osprey-220 and Osprey-230 Hardware . 

 
The Osprey-230 is not supported under Windows NT. 

2. Connect a video signal source to one of the Osprey-220 connectors 
(Composite/S-video). 

3. Open the Osprey MultiMedia Capture group in the Start menu. 
4. Click the VidCap32 icon. 

5. If your input is composite video, the screen displays a preview mode window 
with live video. Click the Overlay button. The screen should display moving 
video frames. If your input choice is not composite video, select the Video 
Source option under the Options menu. This brings up the Osprey-210, 
Osprey-220 and Osprey-230 video capture driver configuration box where you 
select your video input. 
If the video area does not contain video, it could be for one of the following 
reasons: 

a. The driver is looking for video on the wrong input connector. You can either 
move the video cable to another connector or reconfigure the driver using 
its Control Dialog. See Chapter 6 - Osprey-210, Osprey-220 and 
Osprey-230 Video Control Dialog. 

b. The video source is not turned on or activated. 
6. If the video area is scrambled or has bad color, the signal format of your video 

source may be different from the signal format selected in the driver software. 
Since the driver defaults to NTSC-M signal format, users of PAL equipment 
always need to change the driver’s signal format the first time they run the 
driver. See Chapter 6 - Osprey-210, Osprey-220 and Osprey-230 Video 
Control Dialog.  
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Uninstalling the Software 

To remove the Osprey driver from your system:   

1. Open Control Panel. 
2. Double-click Add/Remove Programs. 

3. Click the Install/Uninstall tab. 
4. Click to select the Osprey MultiMedia Capture Driver in the list of programs. 
5. Click Add/Remove. 
6. The uninstall program begins. 

7. Click Yes to proceed. 
8. Click OK when the process is complete. 
9. Please reboot your computer to finish removing the driver. 

 

You have the option of deactivating the Osprey drivers without 
permanently uninstalling them. For example, this option allows you to use 
another device as your primary video capture device. Refer to Appendix 
D - Using the Osprey Video Capture Driver with Other Drivers for 
more information. 

 



 Chapter 6 - Osprey-210, Osprey-220 and Osprey-230 Video Control Dialog 

ViewCast Corporation Osprey-210, Osprey-220 and Osprey-230 User's Guide – 101 

Chapter 6 - Osprey-210, Osprey-220 and 
Osprey-230 Video Control Dialog 

Accessing the Dialog 

General Features of the Dialog 

Cropping and Scaling 

The easiest way to become familiar with the video capabilities of the Osprey-210, 
Osprey-220 and Osprey-230 cards is to run the included video viewing application 
VidCap32 and look at its menus and dialogs. Chapter 8 focuses on the underlying 
video capture driver and the control dialogs that you can access from VidCap32. 

The Osprey-210, Osprey-220 and Osprey-230 video capture driver has a unified 
tabbed dialog for setting up all driver parameters. There are six pages within the 
dialog: 

♦ The Source Page 
♦ The Format Page 

♦ The Closed Caption Page 
♦ The Logo Page 
♦ The Advanced Features Page 

♦ The Configuration Page 
♦ The SimulStream Page is described in the SimulStream User’s Guide 
♦ Cropping and Scaling 

The menu selections Options -> Video Source and Options -> Video Format 
access the Control Dialog's Source and Format pages, respectively. 

The selection Options -> Video Display accesses the Closed Caption page.  

Accessing the Dialog 

The normal way to access the dialog is through a menu entry or control button 
belonging to the application program. For example, VidCap32 offers the following 
three menu entries for accessing the dialog: Options -> Source, Options -> 
Format, and Options -> Display. Once you are in the dialog, you can move to any 
other page by clicking on its tab. For example, to access the Configuration page from 
an application, open the Source, Format, or Display (Closed Caption) page and click 
the Configuration tab. 
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Another way to access the Configuration page is through the Control Panel. 

To access the dialog using Windows NT:   

1. Open the system control panel and Multimedia. 
2. Click the Devices tab. 
3. Open Video Capture Devices. 
4. Highlight Osprey Video Capture Driver. 

5. Click Properties. 
6. Click Settings. 
7. Another way to access the Configuration page (under Windows 2000 only) is 

through the Control Panel. 

To access the dialog using Windows 2000:   

1. Open My Computer -> Control Panel  -> Sounds and Multimedia. 
2. Select the Hardware tab. 

3. Double-click Legacy Video Capture Devices. 
4. Select the Properties tab. 
5. Select Osprey Video Capture Driver. 
6. Click the Properties button. 

7. Click the Settings button. 
To access the dialog using Windows XP:  

1. Open My Computer -> Control Panel -> Sounds, Speech, and Audio 
Devices. 

2. Click Sounds and Audio Devices. 
3. Click the Hardware tab. 
4. Select Legacy Video Capture Devices. 

5. Click Properties. 
6. Click the Properties tab. 
7. Select Osprey Video Capture Driver. 
8. Click Properties. 

9. Click Settings. 
You can open the dialog through the Control Panel at the same time another 
application is accessing the card. This is useful if the application does not provide an 
access control to the dialog. When you open the dialog through the Control Panel, 
some changes such as adjustments to brightness, contrast, etc. display immediately. 
Others will not take effect until the application is restarted.  
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General Features of the Dialog 

These are the common elements found on all pages of the dialog.  

 

OK 

Cancel 

Restore Defaults 

Restore Previous 

Help 

OK 

The OK button exits the dialog, saving the settings you have currently chosen. If you 
have made changes on two or more pages of the dialog, or for two or more boards, 
all of these changes are saved.  

Cancel 

This button exits the dialog box without saving any changes. If you have made 
changes on two or more pages of the dialog, or for two or more boards, all of these 
changes are discarded.  
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Restore Defaults 

This button restores the settings on the current page, for the currently selected 
board only, to the way they were when the Osprey software was installed.  

Restore Previous 

This button restores the settings on the current page, for the currently selected 
board only, to the way they were at the start of the previous dialog session.  

Help 

Clicking Help accesses the pages of this manual covering the currently selected tab.  

The Source Page 

 

Use the Source page to set the characteristics of the input video. 

Input 

Video Standard 

Video Settings 
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Input 

The Input field has buttons for the card’s Composite and S-Video input connectors. 

If Preview or Overlay mode is enabled in your application, you can usually see the 
results of your selection immediately without exiting the dialog. However, if you 
switch between inputs that have two different signal formats, such as NTSC or PAL, 
the video does not display correctly until you exit the dialog.  

Video Standard 

Video Standard refers to whether the video signal format is NTSC, PAL, or SECAM. 
Depending on the exact product version you have, buttons for some or all of the 
following formats are displayed: 

NTSC-M – North America 

NTSC-J – Japan 

PAL-B, D, G, H, I – many countries in Europe and elsewhere. B, D, G, H, and I refer 
to five nearly identical subformats. 

PAL-M – Brazil 

PAL-N, NC – Argentina, Paraguay, Uruguay 

SECAM – France and some other countries. The Osprey-220 product line does not 
currently support this format. 

Full-sized NTSC-M, NTSC-J, and PAL-M have 525 lines total, 480 lines visible, per 
frame and a display rate of 60 fields per second, or 30 interlaced frames per second. 

Full-sized PAL (other than PAL-M) and SECAM have 625 lines total, 576 lines visible, 
per frame and a display rate of 50 fields per second, or 25 interlaced frames per 
second. 

The standard frame sizes are different for NTSC and PAL. For example, the half-
frame size in pixels is 320x240 for NTSC, and 384x288 for PAL. If you have selected 
a standard frame size (Full, 1/2, 3/8, or 1/4), the driver automatically adjusts the 
frame size to correspond to the standard. If you have created a custom size, it does 
not change when you switch between NTSC and PAL/SECAM. 

Changes to the signal controls do not take effect until you exit the dialog.  



Chapter 6 - Osprey-210, Osprey-220 and Osprey-230 Video Control Dialog 

106 – Osprey-210, Osprey-220 and Osprey-230 User's Guide ViewCast Corporation 

Video Settings 

These four slide controls set Brightness, Contrast, Hue, and Saturation. These 
settings are stored separately for each video source. 

NOTE: When using these controls, be sure that the preview mode or overlay mode is 
enabled, so that you can immediately see the effects of your changes. 

When a video source with PAL signal format is used, the Hue setting is not adjustable 
and the Hue control is grayed out. 

The Restore Previous or Restore Defaults button can be used to restore the previous 
video settings.  

The Format Page 

Two different versions of the Format Page display, depending on whether or not 
Enable Cropping is selected. 
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Use the Format page to set the color format and size of the image. 

Color Format 

Video Size 

Custom Size 

Proportions (Pixel Aspect Ratio) 

Cropping  (Please see the CropApp manual for detailed instructions on using this 
feature) 

Color Format 

The Color Format is the arrangement of data bits representing the colors of each 
pixel. For example, in the RGB15 format, each pixel of data is stored as 5 bits of red, 
5 bits of green, and 5 bits of blue color information. 

Video delivered by the Osprey board to the system is in uncompressed format. It is 
possible to compress the video at a subsequent stage of processing. However, this 
dialog field refers specifically to the uncompressed raw video that the board delivers 
to the system. 

The color format you choose applies to Captured video and to Preview video. It does 
not apply to Overlay video. Overlay video is always matched to the display adapter’s 
current screen format - except when greyscale mode is selected. Overlay video is 
therefore as fast and efficient as possible, but the color rendering may differ very 
slightly from what you capture. Preview mode renders colors exactly, but it is slower 
and consumes more system resources. 

Changes to Color Format take effect only after you exit the dialog. 

For a more detailed description of the color modes available, refer to Appendix B - 
Color Modes. 
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Video Size 

The Video Size field allows you to select between the various sizes given below. 
Changes made to Video Size take effect only after you exit the dialog. 

Size Width x Height Also known as: 

Full 640x480  

1/2 320x240 CIF 

3/8 240x180  

1/4 160x120 QCIF 

The width and height shown are in pixels for the North American NTSC-M video 
format in the square (standard) aspect ratio. For further details, refer to Appendix 
C: Video Sizes. 

There is a fifth button, Custom, that becomes selected whenever a non-standard 
size is entered in the Custom Size field. See Proportion (Pixel Aspect Ratio) for 
more detailed information.  

Custom Size 

The Custom Size field allows you to set customized width and height values different 
from the standard preset values of full, 1/2, 3/8, and 1/4. 

If the Fixed Ratio box is checked, when you enter a new size in either the height or 
width box, both dimensions are adjusted proportionately. If this box is unchecked, 
the height and width may be entered independently. If the dimensions are different 
from normal screen proportions, the image is stretched horizontally or vertically. 

The Osprey video hardware is not capable of drawing all possible widths. Depending 
on the color mode selected, it may require a width that is an even number of pixels 
or, for YVU9 and YVU12, a width that is a multiple of 16. The dialog lets you enter 
numbers that the hardware cannot utilize, but adjusts them as soon as you click on 
another field or button of the dialog. 

See Proportion (Pixel/Aspect Ratio) for more detailed information.  

Proportion (Pixel Aspect Ratio) 

This dialog allows you to select between "Standard" (also called a Square aspect 
ratio) and "CCIR601" aspect ratio. 

The maximum resolution of the CCIR601 mode is 720 pixels for both NTSC and PAL. 
The Standard/Square aspect ratio mode has a maximum resolution of 640 pixels for 
NTSC and 768 pixels for PAL. 
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Note that since the sources are processed in a CCIR601 format, the full 768 pixels of 
the standard/square aspect ratio mode of PAL is not available. Only 720 maximum 
pixels are available. If the standard/square aspect ratio mode is selected for PAL, the 
Osprey-210, Osprey-220 and Osprey-230 drivers will limit the maximum resolution 
to only 720 pixels. 

Cropping 

Please see Cropping and Scaling in this Chapter 8 and the CropApp Manual for 
detailed instructions on cropping. 

The Closed Caption Page 

 

Use the Closed Caption page to enable or disable Closed Captioning and to control its 
characteristics. 

Display on Screen 

Save to File 

Mode  

Channel 

Text Color 

Apply Changes to all Boards 
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Closed Captioning is a method of encoding and displaying text such as movie dialog 
captions or stock quotes as part of NTSC video. The text is similar to movie subtitles 
in appearance. Closed Captioning is widely available on broadcast video, cable, 
videotapes, and videodisks. 

The Osprey-210, Osprey-220 and Osprey-230 video driver provides a complete 
implementation of the Closed Captioning standard and special extensions that are 
made possible by the capabilities of a PC.  

You can use Closed Captioning whenever the following conditions are met: 

♦ You must be viewing a videotape, videodisc, or broadcast material that has 
Closed Captioning content. Look for a small “CC” logo on the packaging or in 
the program listing. 

♦ Closed Captioning is for North American NTSC video only, not for PAL video. 
♦ Closed Captioning must be enabled in the Osprey driver, using the Closed 

Caption dialog page as explained above. 
♦ Video Mode and Channel 1 must normally be selected as explained above. 

You might use Text Mode or Channel 2 in specialized instances. 
♦ In addition to the normal options of viewing or capturing Closed Captioning, 

you have the special capabilities to save the text to file as you view or 
capture it.  

Display on Screen 

The Enable checkbox enables display of Closed Captioning on the screen if it is 
checked and disables it if it is unchecked. Closed Captioning currently only is enabled 
for analog (Composite/S-Video inputs). 

If you check or uncheck the Enable checkbox while Overlay or Capture mode is in 
effect, the change does not take effect until Overlay or Capture is stopped and 
restarted. 

It is recommended that you disable Closed Captioning when using non-Closed 
Captioned video. If you leave Closed Captioning enabled, the software attempts to 
interpret regular video as Closed Captioning character codes, and may sometimes 
display spurious characters. It also slightly increases the driver’s CPU usage. 

The normal display mode is Over Video. In this mode the Closed Captioning is 
superimposed on the video field. 

The Own Window option is a special proprietary mode for Closed Caption display. A 
separate window displays, and the text scrolls up in this window instead of appearing 
on the video field. This window disappears while you are capturing video and 
reappears after capturing video. This mode may be useful for some kinds of material, 
as the lines of text are not erased as quickly. The Own Window option, however, 
does not fully conform to Closed Caption standards, especially with regard to line 
placement. It may therefore give undesirable results with some kinds of highly 
formatted captions.  
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Save to File  

A nice feature of Closed Captioning on a PC is that you can save the captions to a file 
for later review. The Save to File field contains three controls: 

1. If checked, the Enable checkbox enables saving to a file. 
2. The Edit Box allows you to designate a file in which the captions will be saved. 

3. The Browse button accesses a standard system dialog for locating a directory 
and file in which the captions will be saved. When you choose a file that already 
exists (either by entering the file name or using the Browse button), new 
captions are appended to whatever was previously in the file. 

You may enable saving to a file without enabling display of Closed Captioning on the 
screen; the two checkboxes are independent.  

 

When SimulStream is in use, only one closed caption session can be 
saved to a file. 

Mode 

Video is the normal Closed Captioning display mode used with almost all videos and 
broadcast TV. Text is a specialized mode in which the entire 32 character by 15 row 
Closed Captioning area of the screen is blanked and used to display text. Use Video 
mode unless you know specifically that the material is Text mode.  

Channel 

Channel 1 is the channel normally used in almost all Closed Captioning. Some 
specialized material may use Channel 2. 

 

Note that with most material, if you select Channel 2, you won’t see any 
Closed Captions. 

Text Color 

Select the color in which you want the closed captioned text to display.  
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Apply Changes to all Boards 

If multiple boards are present, an additional option to Apply changes to all boards 
rather than just the one currently selected appears when closed captioning is 
enabled. 

The Logo Page 

The Osprey Video Capture Driver allows you to superimpose a logo on captured 
video, as in the images below. The “VCST” logos shown illustrate some of the 
features for color keying and translucency that are described below. 

 

 

Use the setup dialog’s Logo page to set up a logo. The logo page is actually a 
sequence of five pages that guide you through the steps of creating a logo and 
placing it on the video. 

You cannot access the Logo page directly from most applications. Instead, open the 
Source or Format page of the dialog, then click on the Logo tab. 
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Capabilities 

Step 0 - Before You Start 

Step 1 - Creating and Enabling the Logo 

Step 2 - Selecting the Logo File 

Step 3 - Setting Key Color and Style 

Step 4 - Positioning the Logo 

Step 5 - Reviewing and Saving the Changes 

Notes on Logos 

Capabilities 

A logo can be any artwork that is formatted as a 24-bit BMP file. Typically, a logo is a 
small graphic that is placed at the lower left of the image. In a technical application, 
however, a logo could be a crosshair pattern placed at the center of the image. The 
logo can theoretically be any size. However, the CPU must actively draw the image 
on every frame of video, and drawing a very large image, even if it is mostly 
transparent, degrades overall performance in high-throughput applications. 

The driver can draw a logo on captured or streaming video, on preview video, or on 
DibDraw overlays. However, the driver cannot draw a logo on DirectDraw overlays. If 
you attempt to draw a logo on DirectDraw overlays, everything appears to work fine, 
except that the logo is not visible. 

A logo’s rectangle can be partially transparent so that the underlying video is visible. 
The transparent areas are defined by a Key Color – a particular (red, green, blue) 
value that is specially interpreted by the driver. For example, the sample logos use 
cyan with red, green and blue values of (0, 128, 128) as the key color. 

A logo displays in either of two styles – normal and embossed. In normal style, the 
logo’s non-transparent pixels simply replace whatever video underlies it. In 
embossed or translucent style, the logo's non-transparent pixels are averaged with 
the underlying video pixels, resulting in a more subtle effect. 

For detailed instructions on setting up a logo, review the following steps: 

Step 0 - Before You Start 

Step 1 - Creating and Enabling the Logo 

Step 2 - Selecting the Logo File 

Step 3 - Setting Key Color and Style 

Step 4 - Positioning the Logo 

Step 5 - Reviewing and Saving the Changes 

Notes on Logos 
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Step 0 - Before You Start 

Create your artwork with the Windows Paint application or any other paint program 
that you like to use. Save it in 24-bit BMP format. 

Before creating your own logo, however, you may want to experiment with the 
samples supplied with the driver. They are located in the Osprey program directory, 
by default \Program Files\Osprey 200\Nt on the default drive. 

Have Preview or DibDraw Overlay mode running when you enter the dialog to see 
immediately the results of interactively defining and placing the logo. DirectDraw 
Overlay mode does not work for this purpose. To change from DirectDraw to 
DibDraw,– or to find out which one you are currently using – go to the dialog’s 
Configuration tab, then stop and restart Overlay mode.  

Step 1 - Creating and Enabling the Logo 

Additional links: 

The Logo Page 

Capabilities 

 

The logo setup pages include detailed explanations at each step. The first page 
handles only one consideration – whether logo drawing is enabled or not. 

By default, the Enable box is not checked and therefore no logo displays. In this 
case, when you click Next>> you go directly to the last page (page 5) of the logo 
setup sequence. 

If the Enable box is checked, you can click Next>> to step through all of the pages 
of the setup sequence.  
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Step 2 - Selecting the Logo File 

Additional links: 

The Logo Page 

Capabilities 

 

 

This screen should be nearly self-explanatory. You are selecting a BMP file, either 
your own artwork or one of the samples. You can type in the full pathname to the file 
or browse for it. When you have selected the file, click Next>>. 

The sample logos are located in the Osprey program directory, by default \Program 
Files\Osprey MultiMedia Capture\Nt on the default drive.  
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Step 3 - Setting Key Color and Style 

Additional links: 

The Logo Page 

Capabilities 

 

As previously noted, a key color is a (red, green, blue) color value that the driver 
treats specially. Logo pixels in that color do not display; the underlying video 
displays instead. This dialog sheet lets you choose one of four fixed key colors, or no 
key color. If you select None for the key color, all pixels from the logo display 
including all pixels in any of the key colors. 

A key color must be a precise (red, green, blue) value. For example, if cyan is 
selected as a key color the pixel values must be exactly (0, 128, 128). A pixel of 
value (0, 127, 127) does not display transparent – it displays as cyan. 

All four key colors are standard stock colors in Windows Paint. 

If the Embossed box is checked, each pixel color value displayed is the average of 
the pixel value of the logo and the pixel value of the underlying video. If Embossed 
is not checked, the pixel color value is simply the value from the logo. 

The key color setting takes precedence over the Embossed setting; that is, logo 
pixels in the key color are transparent, not averaged, even in Embossed style.  
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Step 4 - Positioning the Logo 

Additional links: 

The Logo Page 

Capabilities 

 

The Position control allows you to position the logo by dragging it with the mouse. 
The Nudge controls move the logo up, down, left or right one pixel at a time. They 
permit more precise adjustments than the Position control can achieve. 

If Preview or DibDraw Overlay video is running, the logo moves on the video as you 
move it in the dialog. 

If you position the logo in a certain way and then change the video size, the driver 
stretches the logo to maintain the same relative size, and places it in the same 
relative position. The stretched artwork may have jagged diagonal edges and not 
look as good as unstretched artwork prepared with the intended video size in mind.  
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Step 5 - Reviewing and Saving the Changes 

Additional links: 

The Logo Page 

Capabilities 

 

This page shows a text summary of the current logo configuration. 

If you have multiple boards in the system, a checkbox entitled Apply to all Boards 
appears, as illustrated in the following screen. If you check Apply to all Boards, the 
logo changes you make to the current board are made to all the boards in the 
system. 

 

♦ If you have multiple boards in the system and the only change you 
make is to enable or disable logos, clicking OK with Apply to All 
Boards checked changes the enable/disable status of all boards but 
doesn't change any of the other settings.  

♦ If, however, you make any logo changes other than enable or 
disable, Apply to All Boards copies the entire current configuration 
to all boards. 
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Notes on Logos   

If you set up a logo with video set to one size, then resize video, the logo is scaled 
correspondingly. For example, if the logo is originally set up for 320x240 video, and 
you change to 640x480 video, the logo displays at twice the size of the original 
bitmap. 

1. If you edit the logo settings while the logo is scaled up or down, an additional 
option entitled Rescale displays after Enable. 

 

If you click the Rescale button on this page, the logo is resized to the same 
size as the original source bitmap. 

If you do not click the Rescale button, you can edit the logo settings using the 
scaled logo. Even if you change to another bitmap image, the old scaling is 
maintained. 

2. The driver can display color logos on YUV video – 4:2:2 packed, YUV12 planar, 
and YVU9 planar. The appearance may not be quite the same as the RGB 
version, however. 

3. Detail of colored features may not be as crisp, because in the YUV modes color 
is not sampled at full pixel resolution. 

 

DibDraw Overlay video is always RGB even when you have selected a YUV 
color format in the dialog. Preview video is always in the exact YUV or 
RGB format you have selected. Therefore, when using a YUV mode be 
sure to check the appearance of the logo in Preview mode before putting 
it to use. 

4. When Grey8 video format is selected, all logos including color logos are 
displayed in greyscale.  
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The Advanced Features Page 

Select a link below the screen for more information. 

 

Field Order 

De-Interlacing 

Field Order 

The Osprey-210 or Osprey-220 allows you to configure which pairing of fields will be 
used to construct a frame.  For interlaced capture devices (most current video 
cameras) the field order does not matter and the 'Allow Either' setting will provide 
better performance in VFW preview mode. The default setting for this feature is 
'Allow Either'.  Use the force odd-even or force even-odd settings with a progressive 
scan camera.  Consult your camera's technical documentation for the correct setting 
to use.  Using the correct setting with a progressive scan camera will eliminate 
comb-like interlacing artifacts. 
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De-Interlacing 

Most video is provided for viewing in an interlaced format. For simplicity, NTSC is 
used in the following explanation of an interlaced format. NTSC video is basically 
composed of images taken 60 times a second. Each image is called a field, and there 
are odd and even fields. While these odd and even fields are temporarily adjacent to 
each other in time, the horizontal lines that make up these fields are spatially 
different. 

 

The figure above is a simplistic view of interlaced video and fields. The two fields are 
taken 1/60th of a second apart, and the lines of each field are not aligned, but 
staggered. Most televisions are interlace display devices, where the 60 fields are 
displayed individually and the viewer sees only one field at a time. However, most 
computer monitors are progressive and not interlaced display devices. On a 
computer monitor where video is viewed at its full resolution, viewers see both the 
odd and even fields at once: 

 

The problem with progressive display devices is that if an object is moving, its 
position is not the same in both the odd and even fields. When odd and even fields 
are merged together, interlaced artifacts occurs. The artifacts are seen and 
commonly described as streaking or feathering. 
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The screen above illustrates the streaking or feathering problem that occurred when 
the interlaced odd and even fields in this video were captured. Only a slight amount 
of motion took place, yet streaking is obvious in the overall result. Note the 
prominent horizontal lines outlining all the objects on this screen. 

When feeding such images to an encoder, the encoder has a significantly harder time 
processing and compressing such interlaced video. The result is loss of overall quality 
and perhaps a loss of frame rate as well. While the encoding process may smooth 
out some of these artifacts, the resultant compressed video may still display 
somewhat streaked or feathered and may not play back smoothly. 



 Chapter 6 - Osprey-210, Osprey-220 and Osprey-230 Video Control Dialog 

ViewCast Corporation Osprey-210, Osprey-220 and Osprey-230 User's Guide – 123 

 

The Osprey-210/220's software de-interlacing motion filter can be applied to any 
video source after the optional scale and color-convert phases of processing to 
eliminate streaking or feathering and maintain motion content. In the screen above, 
where the Osprey-210/220's de-interlace motion filter has been turned on, note that 
the strong horizontal streaking or feathering around the subject’s head have been 
smoothed to a slight blur. While the blur is noticeable in a single screen snapshot, 
the human eye perceives only natural motion when the video is played back at 
normal frame rates. 

Feeding the de-interlaced image in the screen above to an encoder significantly 
improves output of the encoder in terms of overall quality and smoothness. The 
encoder has an easier time compressing the de-interlaced video and thus can expend 
saved bits and CPU cycles to produce higher quality streams.   

De-interlacing is optimized for Windows 2000 and above; it will consume fractionally 
more CPU cycles when enabled under Windows NT. 
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The Configuration Page 

 

The Configuration page controls several miscellaneous settings. 

Overlays 

Access to Format Tab 

Multiple Opens 

Default Capture Device 

Overlays   

Direct Draw is a fast drawing method that moves video directly from the Osprey 
capture card to the display adapter. If Use Direct Draw is selected, the driver uses 
Direct Draw for Overlay drawing. If for some reason it cannot use Direct Draw, it 
automatically defaults to DibDraw. 

Direct Draw works with the vast majority of display adapters and software driver. We 
recommend running with Direct Draw enabled unless you are having a problem 
viewing overlay video, or want to use the “doubled lines” option discussed below. For 
more details on Direct Draw, refer to Appendix E - Direct Draw. 
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DibDraw is the default drawing method. Video is moved first into system memory 
and copied to the display adapter. It is useful in the following cases: 

1. For systems where Direct Draw does not work correctly. 
2. If you want to enable “line doubling.” When DibDraw is selected, two radio 

buttons are enabled that let you choose between interlaced and line-doubled 
video. 

Normally, video larger than ½-height (240 lines NTSC, 288 lines PAL) is 
interlaced. NTSC and PAL video both consist of alternating odd and even fields 
of data. Odd numbered lines come from the odd fields, even numbered lines 
come from the even fields. 

Interlaced video offers maximum resolution but suffers from a “comb” effect. 
When there is rapid motion in the video, it displays blurred. It is recommended 
for still or slow-motion video, but may not look good with high-motion content. 

Line-doubled video uses video data from only one field. Each video line is 
copied to two lines of your display. Line-doubling reduces the still-picture 
resolution by half; however, it eliminates the “comb” effect of interlaced video 
and is therefore useful for viewing rapid-motion video. 

3. If you want to stretch the video on your screen beyond full size (640x480 
NTSC, 768x576 PAL). You would need a special application to do this. DibDraw 
video can be stretched but Direct Draw video cannot be.  

Access to the Format Tab 

The two options are: 

♦ Prevent access to a dialog’s format tab via source dialog 
♦ Allow this access 

Video for Windows applications access the Source and Format pages as separate 
commands and do not assume that the driver allows you to switch from one to the 
other. 

Some applications, when they access the Source page, do not check to see if you 
also made changes to items in the Format page. The result is that the application 
and the driver may assume different settings and not work properly together. 

This control in its default “prevent access” setting prevents you from entering the 
Source page or Closed Caption page, switching to the Format page, and 
inadvertently making changes that the application cannot pick up. It also disables 
the Board Select control on the Source and Closed Caption pages since the driver 
maintains separate format information for different boards. The “prevent access” 
setting is recommended for maximum compatibility with all applications. 

The “prevent access” settings is, however, inconvenient. The alternative setting to 
“allow this access” allows you to switch between pages without restriction. This 
works with many applications; however, the responsibility lies with you to make sure 
no problems arise.  
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Multiple Opens 

We recommend that you keep the Multiple Opens box checked unless you have a 
particular reason not to. This will ensure compatibility with the greatest number of 
present and future applications that you might want to use. 

If Multiple Opens is checked, a particular board can be opened for access from 
multiple places, either within a single process or by multiple processes. However, the 
features available through subsequent opens are limited. This mode is needed by 
certain complex applications that, for example, use separate processes for capture 
and overlay. In particular, Multiple Opens should be checked when using Windows 
Media Encoder. 

If Multiple Opens is unchecked (hunt mode), a particular board can be opened for 
access from only one place in one process. If there are multiple boards in the system 
and an application tries to access a board that is already in use, the driver hunts for 
the next available board. This is the easiest way to start multiple copies of some 
applications. 

Changes you make take effect when you click OK to close the dialog. Applications 
such as VidCap32 will not pick up changes until you restart them. 

Review Appendix F - Multiboard Installations for more information. 

Default Capture Device 

This control is useful if you have multiple video capture devices of different kinds. 
These could include cards from other vendors or different kinds of capture cards from 
Osprey. In this context, the Osprey-50, -100, -101, and -200 are considered one 
single device type. The Osprey-500, the Osprey-1000, and the Osprey-2000 are each 
separate device types. 

Some applications are capable of accessing only the primary or default device. With 
this control you can select which device will be the default device such an application 
will use. 

Changes you make are written to the registry when you click OK to close the dialog. 
Applications such as VidCap32 will not pick up changes until you restart them. Some 
DirectX-based applications may not detect changes until you restart the system. 
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The SimulStream Page 

SimulStream is an added-cost upgrade option described in detail in the 
SimulStreaming User’s Guide. 

 

Cropping and Scaling 

The Osprey video capture driver package includes the capability to crop the incoming 
video signal in hardware before it is encoded or captured.  Cropping is done by the 
Osprey card and imposes no extra load on the host computer.  Use any of the 
following methods to crop the incoming video signal: 

♦ Video Format dialog box 
♦ CropApp, the cropping application 

♦ SDK 

Please see the CropApp Manual which is installed in the Osprey MultiMedia Capture 
Program group for details on using this feature. 
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Chapter 7 - Capturing Audio 

Setup and control for audio are much simpler than for video. The basic steps are 
covered in the following topics: 

Select the Audio Source and Input Volume 

Audio Formats 

Audio Playback 

Selecting the Audio Source and Input Volume  

The audio source is set using the Osprey-210/220’s Video for Windows mixer driver 
interface. Most applications, including the Windows Media Encoder applications, 
interface to the mixer driver directly and expose the look and feel specific to that 
application. However, the default Windows interface to the mixer driver can also be 
used. There are two simple methods for getting to the mixer source and volume 
control dialog box. 

 

1. The easiest method for accessing this interface is to right click the speaker 
symbol on your taskbar (typically on the bottom right-hand side of your 
screen). Then select the Open Volume Controls option. 

4. If you do not see the speaker symbol, click the Start button on the Start Menu, 
select Programs->Accessories->Entertainment (or Multimedia) and 
select Volume Control.  For Windows XP, select Start -> All Programs -> 
Accessories -> Entertainment -> Volume Control. 

Either of these two methods brings forth the audio mixer interface for the audio 
playback device. To get to the Osprey-210, Osprey-220 and Osprey-230 audio 
capture (recording) device, select Properties under the Options menu. This pops 
up a dialog to select the Mixer device. Do not select the Recording option within the 
Adjust Volume for section; this option is selected automatically when you select 
the Osprey-210, Osprey-220 and Osprey-230 for the mixer device. Click on the 
dropdown list for Mixer device to see the list of audio input and output devices, 
including the Osprey-210/220. 
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If more than one Osprey-210, Osprey-220 and Osprey-230 card is in the system, 
each Osprey-210, Osprey-220 and Osprey-230 card is enumerated individually. Once 
an Osprey-210, Osprey-220 and Osprey-230 device has been chosen, select OK in 
the Properties dialog box. 

The Osprey-210, Osprey-220 and Osprey-230 Master Control panel displays. 

 

The Osprey-210, Osprey-220 and Osprey-230 device is not a mixer in that it does 
not allow for mixing the various audio sources. Therefore, when one audio input is 
selected, any other input previously selected becomes unselected. The Select 
checkbox at the bottom of each source sets which source is actually being used. 

The Osprey-210, Osprey-220 and Osprey-230 has hardware gain control.  To control 
the hardware gain for the Osprey-210, Osprey-220 and Osprey-230 use the volume 
slider in the mixer applet.  The unity gain setting is when the volume slider is in 
approximately the middle of the range. 

 

The quick-access volume control (left click on the speaker symbol) on the 
task bar controls playback volume and recording volume. To change 
record levels, go to Options, then Properties, and select Recording. 
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Audio Formats 

The only Format that the Osprey-210, Osprey-220 and Osprey-230 audio capture 
driver supports is PCM. The driver supports the following data rates: 

♦ 8 kHz 
♦ 11.025 kHz 

♦ 16 kHz 
♦ 22.05 kHz 
♦ 32 kHz 

♦ 44.1 kHz 
♦ 48 kHz 

These data rates are supported in 8-bit and 16-bit, mono and stereo formats. The 
actual Osprey-210, Osprey-220 and Osprey-230 hardware supports sampling of 
analog audio at 32, 44.1 and 48 kHz. Depending on the requested audio format, the 
Osprey-210, Osprey-220 and Osprey-230 driver automatically selects the most 
appropriate hardware sampling rate. For example, if 22.5 kHz audio is desired, the 
audio driver selects the 44.1 kHz audio rate and down samples it to 22.05 kHz. 

It should be noted that the Osprey-220 does not currently dynamically readjust 
sampling rates while audio capture is in progress. Thus audio capture should be 
stopped and restarted whenever the audio input port changes. 

For mono sources, the Osprey-220 uses only the left audio channel. Optionally, this 
can be configured to be the left channel or a mix of the left and right channels.  

When a capture is started before the audio source is selected, the audio may not be 
sampled at the correct rate. Audio sampled at an incorrect rate will sound slower or 
faster than normal when it is played back. Should this occur, stop and restart 
capturing audio. 

Audio Playback 

The Osprey-210, Osprey-220 and Osprey-230 provides audio capture only, not audio 
playback. Continue to play back captured audio using your system soundcard.  

The Osprey-210, Osprey-220 and Osprey-230 provides a monitoring capability for 
the audio input. A 3.5mm stereo plug on the back of the card provides a hardware 
loopback (post gain) signal. Connecting headphones or speakers to this plug allows 
the user to monitor the audio input. 
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Chapter 8 - VidCap32, Amcap, Control 
Panel, Cropping & Scaling and Indeo 

VidCap32 

Amcap 

DirectX Media Details 

Control Panel 

Cropping and Scaling 

Ligos Technology Indeo 

VidCap32 

 

VidCap32 is a video capture application that is included with the Osprey package. It 
is useful for testing the installation and for general purpose viewing of video. The 
following instructions take you through the basic scenarios for using this applet. 

Preview 

Overlay 

Single Frame Capture 

Configuring the Video Capture Driver in VidCap32 
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Preview 

The Preview button (first button on the left on the toolbar) toggles Preview mode on 
and off. When Preview is enabled, the video you see is constantly updated and has 
the exact format and appearance of uncompressed video capture.  

Overlay 

The Overlay button (second button from the left on the toolbar) toggles Overlay 
mode on and off. When Overlay is enabled, the video you see is updated constantly. 
The difference from Preview is that the Osprey driver uses the fastest and most 
efficient drawing method it can. Normally, with Direct Draw enabled and working, it 
draws at the full frame rate (30 per second) with minimal processor overhead. 

Note that the Preview and Overlay buttons behave like radio buttons that cancel 
each other - you do not have to shut off preview in order to start overlay.  

Single Frame Capture 

The rightmost button on the toolbar is used to capture a single frame. Every time 
this button is selected, a single frame is captured and displayed in the window. You 
can copy this image and paste it into other applications.  

Configuring the Video Capture Driver in VidCap32 

You can go through VidCap32 to access the Osprey driver’s Control Dialog (described 
in Chapter 5). The menu selections Options->Video Source... and Options-
>Video Format... access the Control Dialog’s Source and Format pages 
respectively. The selection Options->Video Display... accesses the Closed Caption 
page. 

Compression 

It is possible to compress video as it is captured to disk. Neither VidCap32 nor the 
Osprey video capture driver perform video compression themselves. However, 
VidCap32 may be connected to external software-based compression modules. 
Compression results in a much smaller capture file. The downside is that many types 
of compression are slower: you may have to reduce your frame rate in order to avoid 
dropping an excessive number of frames. With a “quick-compression” methods 
running on a fast machine, however, the extra processing time is slight enough that 
it is fully compensated for by the reduced time needed to write the more compact 
data to disk. 
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When a compressor is enabled, video is passed from the Osprey capture driver to the 
compressor, which then writes it to file. The compression dialog, accessed by the 
Options->Compression menu item, allow you to select a compressor, or select no 
compression. The information below for Ligos Technology’s Indeo compressor gives a 
detailed example of how to perform this task. 

Note that the list of available compressors is different for each video Color Format 
selected in the Osprey video capture driver’s control dialog. You should therefore 
select the Color Format you are using first, then select the compressor. Otherwise, 
you may get an error message when you try to begin video capture.  

Setting the Capture File - Preallocating and Defragmenting 

The leftmost button on the toolbar (or the menu item File -> Set Capture File) 
opens the Capture File dialog box. 

Depending on a number of factors, you may experience a significant percentage of 
frames dropped. The percentage of frames dropped is a function of frame size, use 
of a compressor, and the speed of your system. Performance can be substantially 
improved by preallocating a capture file and defragmenting it. 

“Preallocating” a file means that space has been reserved for it on your hard disk. 
The menu item File -> Allocate Disk Space brings up a dialog in VidCap32 by 
which you can preallocate a file and reserve space large enough to hold the largest 
video clip that you are likely to want to capture. In AmCap, it is the menu item  
File -> Allocate File Space. You can preallocate multiple files to hold multiple video 
clips. 

For preallocation to be useful, the hard drive should be defragmented afterwards. 
“Defragmenting” a drive reorganizes its physical sectors so that each file occupies 
contiguous sectors, rather than having different parts of it scattered about the disk. 

AmCap and VidCap32 do not perform defragmentation; a third-party program is 
required. Various defragmentation programs are available commercially, and if you 
have Windows 95/98 on the system you can use its built-in defragmenter. Use 
AmCap or VidCap32 to preallocate the files, then exit to run the defragmentation 
program. 

 NOTE: Defragment after you allocate and size the capture files. 

After the disk is defragmented, return to AmCap or VidCap32. The files you 
preallocated are now located in a contiguous areas of the hard drive. Their physical 
layout remains the same until the file is resized or deleted. 

An alternate technique that avoids the need for defragmenting is to set up a 
separate disk partition dedicated to video capture, containing a single capture file. 
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Defragmenting is a time-consuming procedure, but is worth the trouble if you have 
an ongoing need to capture high-quality video, particularly uncompressed video. Be 
sure to plan the number and size of files you need. Once you have the defragmented 
files, be sure not to accidentally delete them - think of them as your permanent 
working space for time-critical operations, not as containers of specific video clips. 
Copy your clips to other files for storage and editing.  

Capturing Video 

The second button from the right opens the Video Capture Dialog. This can also be 
accessed by the Capture -> Video menu item. 

 

The dialog includes controls to set the number of frames per second, as well as an 
optional time limit (in seconds) for the sequence. Buttons are provided to access 
both the video capture driver’s configuration dialog and the compression dialog. You 
can also access and configure audio, assuming that it is installed and enabled. The 
dialog allows a choice between capturing video directly to disk, or capturing via 
memory. Note that capturing to memory may result in fewer dropped frames - but 
not necessarily. 

For best quality video capture, use a capture rate (frames per second) that is slow 
enough so that there are no dropped frames. 

Once the proper configuration is confirmed, click OK to capture the video. To end 
capture, click the mouse anywhere in the VidCap32 window.  

Playback 

The simplest way to play back a video clip is to find its icon in “My Computer” and 
double-click on it. This starts Windows Media Player, which automatically plays the 
clip. Windows Media Player contains standard start, stop, and pause buttons and is 
largely self-explanatory. Refer to Windows Media Player’s online help for more 
information.  
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Amcap 

 

Amcap is a video capture application that is included with the Osprey package. It is 
useful for testing the installation, for general purpose viewing of video, and for 
capturing video to file. Amcap differs from the other general purpose capture 
application, VidCap32, that is included with the Osprey package in that: 

♦ Amcap can handle captured file sizes that exceed the 2 GB limit that 
VidCap32 has. 

♦ Amcap is written using the DirectShow API, and VidCap32 is written using the 
VFW API. Another application that uses DirectShow is Windows Media 
Encoder. 

♦ Amcap does not support software compression modules. 
♦ Amcap's Preview mode is equivalent to VidCap32's Overlay mode. Amcap 

does not have an equivalent to VidCap32's Preview mode. 

Amcap requires the DirectX Media runtime version 6.0 or later in order to run. This 
runtime is included on this CD, and can be installed by the Osprey installation 
program. More information about DirectX Media is available at DirectX Media 
Details. 

The following instructions take you through the basic scenarios for using this applet. 
Amcap has additional capabilities and settings that are beyond the scope of a brief 
introduction. They are described in the applet’s online help. 

Selecting the Amcap Device 

Amcap Preview 

Configuring the Video Capture Driver in Amcap 

Setting the Capture File - Preallocating and Defragmenting 

Capturing Video 

Playback 

DirectX Media Details 
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Selecting the Amcap Device 

 

Amcap requires selecting the input device(s) before you can preview or capture 
video. Use menu item Devices to show a dropdown list of the audio and video 
capture devices present. The video device portion of Osprey-100/200/220 family 
cards will appear as o100vc.dll - Osprey Capture Card 1 in the list. The audio 
device on the Osprey-210, Osprey-220 and Osprey-230 will appear as Osprey 200 
Audio in the same list. If you have multiple Osprey cards present, you can select the 
audio device from this list. Please go to The Format Page for instructions on 
selecting among multiple video sources. 

Multiple board installations are a specialized subject, and are discussed in the section 
entitled Appendix F: MultiBoard Installations.  
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Amcap Preview 

 

When you first start Amcap, there is nothing in the video field display. You must 
enable Preview mode by clicking on the menu item Options -> Preview. When 
preview is enabled, the video you see is updated constantly. What you see is a close 
approximation to the appearance that uncompressed video captured to file will have. 
However, preview video is optimized for fast screen drawing rather than the exact 
capture format, possibly resulting in slight differences in the appearance of the 
video. 

Configuring the Video Capture Driver in Amcap 

You can go through Amcap to access the Osprey driver’s Control Dialog (described in 
Chapter 5). The menu selections Options->Video Source... and Options->Video 
Format... access the Control Dialog’s Source and Format pages respectively. The 
selection Options->Video Display... accesses the Closed Caption page.  

Setting the Capture File - Preallocating and Defragmenting 

The leftmost button on the toolbar (or the menu item File -> Set Capture File) 
opens the Capture File dialog box. 

Depending on a number of factors, you may experience a significant percentage of 
frames dropped. The percentage of frames dropped is a function of frame size, use 
of a compressor, and the speed of your system. Performance can be substantially 
improved by preallocating a capture file and defragmenting it. 

“Preallocating” a file means that space has been reserved for it on your hard disk. 
The menu item File -> Allocate Disk Space brings up a dialog in VidCap32 by 
which you can preallocate a file and reserve space large enough to hold the largest 
video clip that you are likely to want to capture. In Amcap, it is the menu item File -
> Allocate File Space. You can preallocate multiple files to hold multiple video 
clips. 
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For preallocation to be useful, the hard drive should be defragmented afterwards. 
“Defragmenting” a drive reorganizes its physical sectors so that each file occupies 
contiguous sectors, rather than having different parts of it scattered about the disk. 

Amcap and VidCap32 do not perform defragmentation; a third-party program is 
required. Various defragmentation programs are available commercially, and if you 
have Windows 95/98/2000 on the system you can use its built-in defragmenter. Use 
Amcap or VidCap32 to preallocate the files, then exit to run the defragmentation 
program. 

NOTE: Defragment after you allocate and size the capture files. 

After the disk is defragmented, return to Amcap or VidCap32. The files you 
preallocated will now be located on contiguous areas of the hard drive. Their physical 
layout will remain the same until the file is resized or deleted. 

An alternate technique that avoids the need for defragmenting is to set up a 
separate disk partition dedicated to video capture, containing a single capture file. 

Defragmenting is a time-consuming procedure, but is worth the trouble if you will 
have an ongoing need to capture high-quality video, particularly uncompressed 
video. Be sure to plan the number and size of files you will need. Once you have the 
defragmented files, be sure not to accidentally delete them - think of them as your 
permanent working space for time-critical operations, not as containers of specific 
video clips. Copy your clips to other files for storage and editing.  

Capturing Video with Amcap 

 

Amcap requires setting a few options before starting Video Capture. First, set the 
Frame Rate by selecting menu item Capture -> Set Frame Rate... 
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For best quality video capture, use a capture rate (frames per second) that is slow 
enough so that there are no dropped frames. 

If you are capturing audio, then use menu item Capture -> Capture Audio to turn 
on the checkmark for audio capture. 

 

Set the master stream for audio/video synchronization by using the control dialog 
brought up by Capture -> Master Stream to select whether Audio, Video, or none 
is the master stream for synchronization. 

 

You can optionally set a time limit on this capture through the Capture -> Set Time 
Limit... dialog. 

Once the proper configuration is confirmed, click Capture -> Start Capture menu 
item, then click OK on the confirmation dialog to start your capture. If you did not 
set a time limit, use the menu item Capture -> Stop Capture or press the Esc 
button to end your capture.  

Playback 

The simplest way to play back a video clip is to find its icon in “My Computer” and 
double-click on it. This will start Windows Media Player, which will automatically play 
the clip. Windows Media Player contains standard start, stop, and pause buttons and 
is largely self-explanatory. Refer to Windows Media Player’s online help for more 
information. 
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DirectX Media Details 

The DirectX Media functionality is included inside DirectX 7 and later.  Windows 2000 
and Windows XP users do not need to worry about whether to install DirectX Media; 
these versions of Windows ship with a version of DirectX which already contains this 
functionality. 

Information Specific to Windows 2000 and Windows XP 

This CD-ROM may contain version 8.0 of the DirectX Runtime.  Please look at the 
release notes on the CD-ROM for details. 

Information Specific to Windows NT 

The DirectX® Media runtime is included on this CD, and can be installed by the 
Osprey installation program. See the Readme.txt file for details. DirectX® Media 
requires that Microsoft® DirectX® 3.0 or later be installed. Windows Service Packs 4 
and later contain DirectX® 3.0. More information about DirectX and Windows NT is 
available at http://www.microsoft.com/windows/directx/productinfo/ 
overview/faq.asp 

General Information about DirectX Media 

More information about DirectX® Media is available at: 

http://www.microsoft.com/directx/homeuser/information/dx4nt.asp 

and  

http://www.microsoft.com/directx/homeuser/downloads/default.asp - 
DirectX Media. 

The DirectX Foundation Layer consists of Microsoft DirectDraw®, Microsoft Direct3D®, 
Microsoft DirectInput®, Microsoft DirectSound®, Microsoft DirectPlay®, and Microsoft 
DirectMusic®. Thus, DirectDraw is part of DirectX, and is another reason that a video 
display adapter which supports DirectDraw is desirable.  

More information about DirectX is available at: 

http://www.microsoft.com/directx/homeuser/faq.asp  

and 

http://www.microsoft.com/directx/homeuser/aboutdx.asp 

http://www.microsoft.com/windows/directx/productinfo/overview/faq.asp
http://www.microsoft.com/windows/directx/productinfo/overview/faq.asp
http://www.microsoft.com/directx/homeuser/information/dx4nt.asp
http://www.microsoft.com/directx/homeuser/downloads/default.asp#DirectX Media
http://www.microsoft.com/directx/homeuser/downloads/default.asp#DirectX Media
http://www.microsoft.com/directx/homeuser/faq.asp
http://www.microsoft.com/directx/homeuser/aboutdx.asp
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The latest version of all DirectX downloads can always be found at:  

http://www.microsoft.com/downloads/details.aspx?FamilyID=9909ba22-
8caa-4241-954c-e7d710e18522&displaylang=en 

Because DXMedia is not part of the current DirectX releases, it can be downloaded 
from: 

http://www.microsoft.com/downloads/details.aspx?FamilyID=9909ba22-
8caa-4241-954c-e7d710e18522&displaylang=en 

The DirectX Media package is distributed with Microsoft’s DirectX 7.0a SDK, which 
can be ordered on CD from Microsoft.  The DirectX Media package has also been 
distributed on the Platform SDK CD in MSDN subscriptions. 

 

The DXMedia package ONLY needs to be installed on Windows NT4.0 
machines.  This functionality is part of the Windows 2000 and Windows XP 
operating systems. 

Control Panel 

 

The Osprey video capture driver package includes a Control Panel application that 
allows you to control the video source while another application is running. Some 
applications make it hard or impossible to access the driver’s control dialogs while 
they are running. The Control Panel allows you to make these adjustments without 
closing and restarting the primary application. 

Video Input 

Video Format 

Video Adjustments 

Board Select 

http://www.microsoft.com/downloads/details.aspx?FamilyID=9909ba22-8caa-4241-954c-e7d710e18522&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=9909ba22-8caa-4241-954c-e7d710e18522&displaylang=en
ftp://www.microsoft.com/developer/platformsdk/july2000/common/redist/dxmedia
ftp://www.microsoft.com/developer/platformsdk/july2000/common/redist/dxmedia
http://www.microsoft.com/downloads/details.aspx?FamilyID=9909ba22-8caa-4241-954c-e7d710e18522&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=9909ba22-8caa-4241-954c-e7d710e18522&displaylang=en
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Video Input 

The Video Input field controls which of the board’s physical inputs to use. The list of 
available inputs may vary from the illustration depending on the exact hardware you 
have.  

Video Format 

The Video Format field indicates whether NTSC or PAL video is selected and allows 
you to change the format. NTSC is the video standard in North America and Japan. 
PAL is the standard in most European countries, and many other countries as well. 
For simplicity, NTSC and PAL are the only two formats that can be selected from the 
Control Panel. The driver supports additional, less commonly used format with its 
internal dialogs (see Chapter 5), in particular SECAM and PAL-M.  

Video Adjustments 

The Video Adjustment sliders allow you to interactively control the brightness, 
contrast, saturation, and hue of the video being captured or displayed by the primary 
application. PAL video does not have a hue adjustment.  

Board Select 

The Board Select field is displayed and used only when there are multiple Osprey 
cards installed in the system. The buttons of this field determine which of two, three, 
or four boards is currently being controlled. 

NOTE: These buttons affect which board is being controlled, not which board the 
application is connected to. Their action is therefore slightly different from the Board 
Select controls in the driver’s internal Setup Dialogs. 

Cropping and Scaling 

The Osprey video capture driver package includes the capability to crop the incoming 
video signal in hardware before it is encoded or captured.  Cropping is done by the 
Osprey card and imposes no extra load on the host computer.  Use any of the 
following methods to crop the incoming video signal: 

♦ Video Format dialog box 

♦ CropApp, the cropping application 
♦ SDK 

Please see the CropApp Manual which is installed in the Osprey MultiMedia Capture 
Program group for details on using this feature. 
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Ligos Technology Indeo 

Ligos Technology’s Indeo is a software video compressor that works with the Osprey 
Video Capture Driver. It allows you to capture video to disk using much less disk 
space, at the cost of only a slight loss of picture clarity. On a 300 MHz Pentium II 
system you can capture 320x240 NTSC video at a full 30 frames per second with a 
25:1 compression ratio. 

Indeo is included on Osprey Multimedia Capture Driver CDs starting with Osprey 
version 1.50. Refer to Installing Ligos Technology's Indeo for detailed 
installation instructions. Ligos Technology has acquired the Indeo® Media Software 
from Ligos Technology Corporation. This codec is rather popular, so you may see 
references to both Ligos Indeo and Ligos Technology Indeo for some months. 

You can also download the most up-to-date version for free on Ligos’ web site. As of 
this writing, the location is as follows: 

http://www.ligos.com/indeo/downloads/ 

The file to download currently is iv5setup.exe. You need a version that will 
compress video as well as decompress it. 

Indeo Video compressor version 5.11 works with RGB24 and RGB15. It does not 
work with YUV12 or YVU9. However, the Indeo package does include components 
you can use to capture uncompressed YVU9 and 4:2:2 packed video. 

To demo Indeo with the Osprey card:  

1. Connect and adjust your video source. Start VidCap32. 
2. Use the Options->Format... menu entry to bring up the Osprey driver’s 

Control Dialog Format page. In the drop-down list in the Color Format field, 
select RGB24 (or RGB15). Select ½ sized (CIF) video. Click OK. 

3. Use the Options->Compression... menu entry to bring up the compression 
dialog. In the Compressor: field, select Indeo video 5.11. 

 

http://www.ligos.com/indeo/downloads/
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4. Before leaving the compression dialog, click the Configure... button. Enable 
Quick Compress in the Encoder Controls field, and click OK. 

NOTE: If you do not enable Quick Compress, compression will be much slower. 
Click OK again to close the Video Compression dialog box. 

 

5. Select Set Capture File.. under the File menu. Set the name that you want for 
the file that will contain the captured video. Click Open. 

6. Select Capture->Video. Select 30 frames per second for NTSC or 25 for 
PAL/SECAM. Click OK. A confirmation dialog appears. Click OK again to start 
capturing video. 

7. Click anywhere on VidCap32 when you want to end capture 
8. Open My Computer and navigate to the icon of the file that you just captured. 

Click on it and it will play back. 

If you experience more than one or two dropped frames, use a lower frames per 
second capture rate. Useful rates for NTSC video are 30, 15, 10, and 7.5; for 
PAL/SECAM, 25, 12.5, 8.33, and 6.25. 

Indeo has numerous options. You can obtain higher quality video and more 
compression options by capturing uncompressed video and then compressing it off-
line. 
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Chapter 9 - Troubleshooting 

Blue/Pink/Black/Orange Video Screen 

Black Preview Video Screen 

Scrambled Video Image 

Grainy, Dithered Image 

Slow Overlay Drawing 

Problems Using Direct Draw 

Poor Video Quality at Large Frame Sizes 

Wrong Capture Driver Being Accessed 

Unwanted Closed Caption Text 

Interrupt Conflicts 

Cannot Play Back Audio Recorded by the Osprey-210, Osprey-220 and 
Osprey-230 Card 

Multiple Horizontal Lines Across Video Image 

Video Control Dialog Windows are Empty under WinNT 

Blue/Pink/Black/Orange Video Screen 

The currently selected video input is not receiving an active video signal. Different 
inputs may provide a different symptom when a video source is not supplied. 

♦ Check that the camera, VCR, or other video source is powered and that its 
output is connected to the Osprey card’s input. 

♦ Check that the correct video input is selected in the Control Dialog’s Source 
page.  

Black Preview Video Screen 

If you select a Color Format other than one of the RGBs or Grey8, you may get a 
black preview screen. You may also get a message such as “Error: Unable to draw 
this data format”. The problem is that Video for Windows does not know how to 
decode these more specialized formats. It must be able to locate a software video 
decompressor on your system that works with this format. 
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If you encounter this situation with a Color Format that you need or want to use, you 
have to obtain a suitable compressor. For example, if you install Ligos Technology’s 
Indeo compressor you can preview the YVU9 format. To download from Ligos 
Technology’s web site: 

http://www.ligos.com/indeo/downloads/ 

Scrambled Video Image 

You may have set the wrong video signal format for the signal input you are using. 
For example, you may have told the driver to look for NTSC-M video but are using a 
PAL-BDGHI video source. Make sure you know what signal format your video source 
is generating. Go into the Video Standard field of the Control Dialog’s Source page, 
and click the button for that signal format.  

Grainy, Dithered Image 

Check that you are using a display format with greater than 256 colors. If a 256 
color format is used, the system can only approximate the actual colors, and does so 
with a loss of resolution and precision.  

Slow Overlay Drawing 

You should be able to obtain 30 frames per second with minimal processor loading 
by enabling Direct Draw. System requirements for realizing this speed are: 

♦ a video display card that supports Direct Draw 

♦ a video display device driver for the card that supports Direct Draw 

Either or both of the two checkboxes in the Direct Draw field of the Control Dialog’s 
Configuration page must be checked. 

Refer also to Appendix E - Direct Draw.  

http://www.ligos.com/indeo/downloads/
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Problems Using Direct Draw 

Direct Draw is a recent technology and it is possible that you may have problems 
using it with your particular combination of display adapter, display driver, and 
machine. Any problems should arise only when Overlay mode screen drawing is in 
use; the Osprey card does not use Direct Draw at other times. If you do have 
problems, disable either or both Direct Draw methods by unchecking their boxes in 
the “Direct Draw” field of the Control Dialog’s Configuration page. We have seen 
problems with Secondary Direct Draw on a few older display adapters. Refer also to 
Appendix E - Direct Draw, for more details.  

Poor Video Quality at Large Frame Sizes 

Large frame sizes with the deep pixel depth (24- or 32-bit), or complex format 
(YVU9 or YUV12 planar), impose heavy demands on the PCI bus’s data transfer 
capacity. Our experience is that some systems cannot handle these formats at full 
frame sizes. 

Systems vary in their data transfer limits. The characteristics of the PCI bridge are 
often more important than processor speed. If you are having problems, we 
recommend that you: 

♦ Use a smaller frame size (480x320 or less). 
♦ Use a shallower color format (RGB15 or RGB24 instead of RGB32). 
♦ Try an RGB format instead of a YVU format, and a packed format instead of a 

planar format. 

♦ If you have a choice of PCs for video capture, try using another system with a 
different system board chipset.  

Wrong Capture Driver Being Accessed 

This might happen if you already had another capture board/capture driver on your 
system when you installed the Osprey card. The Osprey installation procedure allows 
you to set the Osprey driver as either the primary or secondary video capture driver. 
Appendix D - Using the Osprey Video Capture Driver with Other Video 
Capture Drivers gives a full description of how to set the Osprey driver as the 
primary driver. 

Some applications, including VidCap32, allow you to select which video capture 
driver to use. In VidCap32, a list of installed video capture drivers is appended to the 
bottom of the Options menu.  
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Unwanted Closed Caption Text 

Closed Caption text consists of white or colored characters drawn on black character 
cells. 

In video that contains Closed Captioning information, the first active line of video in 
each field contains encoded Closed Caption text. In video that does not have Closed 
Captioning information, that line is simply ordinary video. 

If you leave Closed Captioning enabled and view non-Closed Caption video, the 
Osprey video capture driver attempts to interpret the first line of each field of video 
as Closed Caption character codes. Some video may appear sufficiently similar to 
Closed Caption data that the software thinks it is Closed Caption text. The result is 
occasional randomly drawn text appearing on the screen. 

The solution is to turn off Closed Captioning when you are viewing sources that are 
not Closed Captioned. To do so, open the Control Dialog’s Closed Caption page and 
uncheck the Enable box in the Display field. The change takes effect when video is 
restarted after exiting the dialog. 

For more information about Closed Captioning, refer to The Closed Caption Page.  

 
PAL video sources do not contain closed captions. 

Interrupt Conflicts 

Failed network connections, failure of a device drive to initialize during start-up, or 
failure of the Osprey card and driver to operate properly are often traced to interrupt 
(IRQ) conflicts. In our experience, IRQ conflicts are most commonly seen when a PCI 
SCSI adapter, or possibly a PCI network adapter, is present in the system. 

Conflicts Between PCI Cards 

Conflicts of PCI Cards with ISA Cards 

Conflicts Between PCI Cards 

PCI cards and drivers do not choose which IRQs they use; rather, the operating 
system assigns IRQ lines to PCI cards. The IRQ configuration for the Osprey card or 
cards is determined by Windows NT/Windows 2000/Windows XP, and the Osprey 
driver cannot change this configuration. However, you can cause the operating 
system to assign IRQs differently by rearranging cards or changing BIOS settings. 
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Multiple PCI cards are supposed to be able to share the same IRQ line. In practice, 
occasionally you may encounter a device driver that is not implemented correctly for 
interrupt sharing. If this problem arises, you have to rearrange the PCI cards so that 
the non-compliant card does not share its IRQ line with any other device. 

Another problem is that some PCI device drivers expect to use a particular IRQ line. 
When a new card is added, it causes the system to assign IRQs differently. If the IRQ 
assignment for a particular card is changed and its device driver does not detect the 
change, this causes the system to work incorrectly. 

The simple answer to this problem is it can sometimes be solved by physically 
rearranging the PCI cards such that their arrangement in the PCI slots is different. 
When doing this, keep careful notes of the arrangements you have tried. 

Another approach to PCI card conflicts is at the BIOS level. Depending on what kind 
of system BIOS you have, you may be able to change which IRQ lines are allocated 
to PCI devices versus ISA devices. You may be able to allocate more IRQ lines for 
PCI devices and thereby solve a PCI conflict. 

If these approaches do not work, see Getting Help in Chapter 1.  

Conflicts of PCI Cards with ISA Cards 

A PCI card and an older-style ISA card can never share IRQ lines. Windows NT 
cannot detect with certainty what IRQ line an ISA card is using and cannot always 
prevent the conflict. 

You can view the system’s IRQ assignments by running the Windows NT Diagnostics 
program in the Administrative Tools menu or program group. Select the Resources 
tab and click the IRQ button at the bottom of the field. If the list of cards shows an 
ISA card using the same IRQ as another device, the conflict should be resolved by 
changing the IRQ of the ISA card. 

Unfortunately, if a device driver for an ISA card has failed to initialize because of an 
IRQ conflict, the card’s IRQ does not appear in the list. To find the conflict, you have 
to examine all your ISA cards with the Control Panel to find out what IRQs they are 
trying to use.  
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Cannot Play Back Audio recorded by the 
Osprey-210, Osprey-220 and Osprey-230 
Card 

If you have a sound card installed, you should be able to hear audio when you play 
back recorded audio. 

♦ Verify that the volume control for your playback device is not muted. 

♦ Verify that the selected playback device is your sound card, and not the 
Osprey-210, Osprey-220 and Osprey-230 Placeholder device. The Placeholder 
device exists in order to handle the situation where there is an Osprey-210, 
Osprey-220 and Osprey-230 present without a sound card. Some Windows 
applications cannot use a recording device unless a playback device is also 
installed. The Placeholder device cannot play back recorded audio. You can 
use the same method to select playback device that you use when selecting 
the audio source.  

Multiple Horizontal Lines Across Video 
Image 

If there are multiple, regularly spaced, horizontal lines across your video image and 
your source material is copyrighted and copy-protected, you are seeing 
Macrovision™ copy protection. It looks like this: 
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The lines can vary in color from yellow to blue to green. These lines are not present 
in every frame of video. There may also be a black band at the top of the frame. 

The Osprey-210, Osprey-220 and Osprey-230 cannot eliminate these video artifacts. 
These artifacts will only be present when you are using a copy-protected source, 
such as a high-quality DVD for testing a card.  

Video Control Dialog Windows are Empty 
under WinNT 

This problem occurs only for Windows NT installations that are running Service Packs 
earlier than SP4, or that are running versions of Internet Explorer earlier than 
version 4. The problem is caused by the Osprey driver software's use of features 
(window dialog controls) provided by Windows NT that were introduced in 1999.  

This problem can be fixed by: 

♦ applying NT Service Pack 4 or later.   

 

Service Pack 6a  is required to use Microsoft's Windows Media Encoder 7.1 
and Media Player 7.1. 

♦ installing Internet Explorer version 4 or later 
♦ downloading and installing the latest version of 401Comupd.exe from 

Microsoft's website at 
http://www.microsoft.com/msdownload/ieplatform/ie/comctrlx86.a
sp 

http://www.microsoft.com/msdownload/ieplatform/ie/comctrlx86.asp
http://www.microsoft.com/msdownload/ieplatform/ie/comctrlx86.asp
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Appendix A - Hardware Specifications 

The physical specifications for the Osprey-210, Osprey-220 and Osprey-230 Capture 
Cards are as follows. 

Table A-1   Physical Dimensions – Osprey-210 and Osprey-220 

Length 133 mm 

Width 22 mm 

Height 121 mm 

Weight 63 grams 

Table A-1   Physical Dimensions – Osprey-230 

Length 152 mm 

Width 22 mm 

Height 64 mm 

Weight 63 grams 

Table A-2   Environmental Specifications 

Operating temperature range 0º to 40º C 

Non-operating temperature range -40º to +75º C (RH) 

Operating humidity range Between 5% and 80% (non-condensing) 
@ 40º C 

Non-operating humidity range 95% RH (non-condensing); gradient 
30% per hour 

Operating altitude range 0 to 3,048 meters (10,000 feet) 

Non-operating altitude range 0 to 15,240 meters (50,000 feet) 
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Appendix B - Color Modes 

The Color Format field of the Control Dialog’s Format page allows you to select the 
following video formats. 

RGB32 - Each pixel has four bytes (32 bits) of data - one each for red, green, and 
blue, plus one byte of padding. The pixel has 256 shades of each of the three colors, 
for a total of 16.7 million colors. This is a “true color” mode. 

RGB24 - Each pixel has three bytes (24 bits) of data - one each for red, green, and 
blue. This is another “true color” mode with 16.7 million colors, and is a 
recommended format for capturing images with the highest possible color accuracy. 

RGB15 - Each pixel has two bytes (16 bits) of data. There are 5 bits each of red, 
green, and blue data; the sixteenth bit is unused. This is a “high color” mode, also 
known as “5:5:5.” 

Grey8 - Each pixel has one byte of data, representing one of 256 greyscale levels. 

4:2:2 packed - Also known as YUY2. This mode represents each pixel with a total 
of 2 bytes (16 bits) of data. The data is encoded as separate data for luminance 
(intensity) and chrominance (color). This mode is mainly used as an input to 
software compressors. See YUV Format Details. 

YUV12 planar - Also known as I420. This is a complex format in which there are in 
the aggregate 12 bits of data per pixel. Each pixel has 8 bits of luminance data. Each 
group of 4 adjacent pixels shares two bytes of chrominance data. See YUV Format 
Details. 

YVU9 planar - Similar to YUV12 planar, except that there are in the aggregate 9 
bits of data per pixel, and each byte pair of chrominance data is shared by 16 
adjacent pixels. See YUV Format Details. 

YUV Format Details 

4:2:2, YVU9, and YUV12 are YUV formats. In these formats, each pixel is defined by 
an intensity or luminance component, Y, and two-color or chrominance components, 
U and V. Since the human eye is less sensitive to color information than to intensity 
information, many video formats save storage space by having one luminance byte 
per pixel while sharing the chrominance byte among two or more pixels. YUV is also 
very similar to the color encoding used for analog color television broadcast signals. 

4:2:2 packed mode consists of a single array of mixed Y, U, and V data. Each pixel 
has one Y (intensity) byte. Each pixel shares its U and V bytes with one of the pixels 
horizontally next to it: 
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pixels 1 and 2: byte 1 = y1 byte 1 intensity 

 byte 2 = u1/2 shared U color information for bytes 1 and 2 

 byte 3 = y2 byte 2 intensity 

 byte 4 = v1/2 shared V color information for bytes 1 and 2 

   

pixels 3 and 4: byte 5 = y3  

 byte 6 = u3/4  

 byte 7 = y4  

 byte 8 = v3/4  

4:2:2 packed mode uses the same number of aggregate bytes per pixel as RGB15, 
which is two. However, 4:2:2 is more efficient than RGB15 because it stores 
relatively more of the intensity information to which that the human eye is most 
sensitive. 

YVU9 and YVU12 are "planar" modes - the Y, U, and V components are in three 
separate arrays. It is easiest to explain the format with an example: Let's say you 
have a 320x240 YVU9 format. The buffer has 320x240 bytes of Y data, followed by 
80x60 bytes of V data, followed by 80x60 bytes of U data. So each U and each V 
byte together contain the color information for a 4x4 block of pixels. 

Similarly, a 320x240 YUV12 format has a 320x240 Y array, followed by a 160x120 U 
array, and then a 160x120 V array. 

 

Note that in the I420 format used by Osprey, the order of the U and V 
arrays is reversed from the order in the YVU9 format. 
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Appendix C - Video Sizes 

The table below gives the standard video sizes available through the Control Dialog’s 
Format page. 

The 525-line video formats are NTSC-M, NTSC-J, and PAL-M. 

The 625-line video formats are PAL-BDGHI, PAL-N, and PAL-NC. 

CCIR601 is a video proportioning standard that can be selected on the Control 
Dialog’s Format page. 

Available Video Sizes 
(Width x Height:) 

 525-line 
(Sqr Pixels) 

525-line 
(CCIR601) 

625-line 
(Sqr Pixels) 

625-line 
(CCIR601) 

Full 640x480 720x480 768x576 720x576 

1/2 (CIF) 320x240 360x240 384x288 360x288 

3/8 240x180 270x180 288x216 270x216 

1/4 (QCIF) 160x120 180x120 192x144 180x144 

 



Appendix C - Video Sizes 

160 – Osprey-210, Osprey-220 and Osprey-230 User's Guide ViewCast Corporation 

 



 Appendix D - Using the Osprey Video Capture Driver with Other Drivers 

ViewCast Corporation Osprey-210, Osprey-220 and Osprey-230 User's Guide – 161 

Appendix D - Using the Osprey Video 
Capture Driver with Other Drivers 

 

The following information is valid for Window NT 4.0 only, not for 
Windows 2000 or Windows XP. 

If you already have a video capture driver installed in your system, the Osprey 
installation software offers the option of installing the Osprey driver as your primary 
video capture driver. A dialog box with that option displays near the end of the 
installation sequence. 

The Windows 2000 and Windows XP installer does not offer this option. 

After installation, you can change the primary video capture driver by going to the 
Configuration Page of the driver's setup dialog and then to the Default Capture 
Device option. 

If the Osprey driver is set as your primary video capture driver, it will automatically 
connect to Video for Windows applications as the default driver. If you install it as a 
secondary or auxiliary video capture driver, it will not be accessible to Video for 
Windows programs and utilities that lack a control for selecting a specific capture 
driver. Your other driver, however, remains immediately accessible as the default 
driver. 

What if you have a need to change drivers and capture cards, once or repeatedly? 
The most safe-and-certain way is to run the old driver’s uninstall program and then 
run the new driver’s install or setup program. You may find it easier, however, to use 
the system Control Panel to remove and install drivers. 

The Control Panel’s “Remove” does not actually remove a driver permanently from 
your system. Its files are still in the same locations on your hard disk. Rather, it 
alters the registry settings so that the driver does not appear on the list of active 
drivers. When you later “Add...” a driver that is removed in this way, you have the 
choice of using the existing files, or copying in new ones. 

Use the Control Panel’s Multimedia Add... function to activate the primary driver you 
want. The Add... function replaces the previous primary driver with the new one. 
This is usually in fact what you want to do. There is no way to designate a driver as 
secondary or auxiliary using the Control Panel. 

Because the NT 4.0 Add... function acts more like a “Replace...” function if a driver 
is already there, the Remove function is not really needed. This is fortunate, 
because it does not work for all video capture drivers. It appears to, but the registry 
does not actually get updated. (For the Osprey driver, the Remove function does 
work.) If both a primary and a secondary driver are installed, and you Remove the 
primary driver, and the function works correctly, the secondary driver becomes the 
primary driver. 

To "Add..." a driver, proceed as follows: 

To "Remove" a driver, proceed as follows: 
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To "Add..." a Driver  

 

The following information is valid for Window NT 4.0 only, not for 
Windows 2000 and Windows XP. 

1. Open My Computer and double click on the Control Panel icon. The Control 
Panel window will come up. 

2. Double click on the Multimedia icon. The Multimedia Properties window will 
come up. 

3. Click on the Devices tab. A list of multimedia devices will appear. 
4. Click on the Video Capture Devices selection; it should become highlighted. 
5. Click the Add... button at the bottom of the window. A window titled Add 

appears, with a list of drivers. 
6. If the driver you want to add is in the list, highlight it and click OK. Follow 

whatever further directions come up that are specific to the driver. 
7. If the driver you want is not on the list, highlight the first item, Unlisted or 

Updated Driver, and click OK. 
8. You now get a dialog that prompts for a pathname. You have to provide the 

location of an “INF” file for the driver. This is a file belonging to the driver of 
interest entitled “o100drv.inf”. You can either type in the path or click the 
Browse... button to select the path. For the Osprey software, this file will be in 
the directory where the software was installed, by default \Program 
Files\Osprey Multimedia Capture on the default drive. When you have the 
correct path in the dialog, click OK. 

9. A dialog entitled Add Unlisted or Updated Driver will now come up. There could 
be several choices of drivers; if so, select the one for a video capture driver and 
click OK. 

10. Follow any further directions specific to the particular driver that come up.  
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To "Remove" a driver  

 

The following information is valid for Window NT 4.0 only, not for 
Windows 2000 and Windows XP. 

1. Open My Computer and double click on Control Panel. The Control Panel 
window will come up. 

2. Double click on the Multimedia icon. The Multimedia Properties window will 
come up. 

3. Click on the Devices tab. A list of multimedia devices will appear. 
4. Click on the plus sign to the left of small icon marked Video Capture Devices. 
5. Click on (and highlight) the video capture device you want to remove. 

6. Click on the Remove button at the bottom of the window. 
7. A confirmation dialog will come up. Click Yes to deactivate the driver. 
8. Verify that the driver was actually removed by closing the Multimedia window, 

restarting it, and seeing if the driver is in fact gone from the Video Capture 
Device list.  
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Appendix E - Direct Draw  

Direct Draw is a fast on-screen drawing method. The Osprey video capture driver 
utilizes Direct Draw for drawing video overlays. Video overlay is a display mode 
available in most video capture applications, including VidCap32. It is enabled by 
clicking an Overlay button, or by selecting an Overlay menu entry. It is distinct from 
Preview mode. Preview mode does not utilize Direct Draw. 

Direct Draw is enabled by the Direct Draw Enable checkbox on the Control Dialog’s 
Configuration Page. When Direct Draw is enabled, the Osprey driver attempts to 
use it for overlays. If it cannot (e.g., the display driver does not support Direct 
Draw), the Osprey driver defaults to DibDraw. 

When Direct Draw is used, video is copied by direct memory access (DMA) directly 
from the Osprey board to the visible screen memory, and video is overlaid at 30 
frames per second with very low main processor utilization. When Direct Draw is not 
used, video is copied by DMA into system memory, and then copied again into 
display memory. Frame rate without Direct Draw is 30 per second for smaller frame 
sizes, but less for larger sizes, and processor loading is substantial. 

In order to utilize Direct Draw, the following conditions must be met:  

1. You have to enable Direct Draw by checking the Enable button on the Control 
Dialog’s Configuration page. 

2. Your video display card must support Direct Draw. 
3. The software device driver for your video display card must support Direct 

Draw. It is recommended that you use the most recent driver available. The 
drivers on the Windows NT 4.0 CD-ROM do not support Direct Draw in all cases. 
You can obtain the most recent version from your video card manufacturer’s 
web site. 

4. You must be using a video format other than Grey8. The Osprey driver does not 
support Direct Draw of greyscale video. 

5. You can tell whether the system is using Direct Draw as follows: When Direct 
Draw is in use, the display near the video capture window flickers when either 
the video capture window or an overlapping menu or window is moved. When 
DibDraw is being used, there is no flicker. 

6. You can also measure CPU utilization using the Task Manager’s performance 
meter. When measuring CPU utilization, first shut down any applications that 
might be actively consuming significant CPU time. CPU utilization will be just a 
few percent when Direct Draw is running. If DibDraw is running, CPU utilization 
will be substantial, especially if the image is large.  
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Appendix F - Multiboard Installations 

The multiboard capability of the Osprey-210, Osprey-220 and Osprey-230 Capture 
Driver allows both single and multiple applications to simultaneously access multiple 
boards. However, the driver does not allow multiple applications or processes to 
access a single board unless the added-cost SimulStreaming option has been 
enabled for the board, or another special circumstance exists. 

First, some background on the logic by which the Osprey-210, Osprey-220 and 
Osprey-230 driver determines connection or startup order for multiple boards: the 
numbering of the boards is determined by the order in which the operating system 
recognizes their presence in the slots in which they are installed. The arrangement of 
logical PCI slots is different for different machines, and you should experiment to 
determine which physical board is Board 1. Also, the numbering under Windows 
2000 and Windows XP may differ from the numbering under Windows NT 4.0. 

Every time the system is rebooted, the Osprey Video Capture drivers enumerate the 
boards in the system and make unique video capture entries for each board. If the 
Multiple Opens box is not checked to allow multiple opens of each board on The 
Configuration Page of the Osprey Video Capture Driver's Control Dialog, a default 
entry is made that represents the legacy method of opening multiple devices, as well 
as registry entries for individual boards. If the box is not checked (the recommended 
method), only entries for specific cards are created. 

The Recommended Multi-Board Selection 
Approach 

The recommended method is to check the Multiple Opens box on The 
Configuration Page of the Osprey Video Capture Control Dialog. Not checking this 
box results in the generation of only individual names as video capture device 
entries. For example, the following msvideo entries appear for two Osprey Video 
Capture devices in the system: 

o100vc.dll - Osprey Capture Card 1 
o100vc.dll - Osprey Capture Card 2 

These "Card 1/Card 2" names should be used when opening an Osprey-100 or 200. 
In the event that you see a "Card Default" entry (see The Legacy Multiboard 
Selection Approach below), this entry is for legacy applications that did not allow for 
specific device selection. When using the device specific (numbering) approach to 
open the device and bring up the video driver's Control Dialog, the correct board is 
automatically selected in the Board Select field box. 
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The Legacy Multi-Board Selection 
Approach 

The non-recommended method is not to check the Multiple Opens box on the 
Configuration Page of the Osprey Video Capture Control Dialog. Checking this box 
results in the generation of individual device names, as well as a Card Default name, 
as video capture device entries. For example, the following msvideo entries appear 
for two Osprey-200 devices in the system: 

o100vc.dll - Osprey-100 Card Default 
o100vc.dll - Osprey Capture Card 1 
o100vc.dll - Osprey Capture Card 2 

If two or more boards are installed and you use the default device name to access 
the Osprey driver, it first connects to the default board. Normally, the default board 
is whichever board was most recently selected in the Board Select field of the Control 
Dialog. If this default board is in use (and the MultiOpen option is turned off), the 
next available board is automatically selected. Once any board is selected, you can 
change it to a different board by opening any page of the video driver's Control 
Dialogs with a board select field, selecting the board that you want, and clicking OK. 

If you have a mixture of Osprey-200 and Osprey-100 boards installed, then 
situations can exist where a particular board is addressed as "Board 2" for the video 
driver, and "Osprey-200 Audio board 1" for the audio driver. When mixing 
audio/video and video-only boards, it is prudent to verify how the boards are 
numbered by your operating system before you begin capture. 

Multiple boards may be accessed according to three main scenarios: 

♦ Multiple processes accessing multiple boards: Start two standard applications 
- or two copies of one application - such as VidCap32. The first copy will come 
up connected to the default board and will start normally. The second copy 
will automatically hunt for the next available board in ascending numerical 
order. 

♦ A single application accessing multiple Boards: A single custom application 
can access two or more different boards. If the standard Video for Windows 
interface is used, the access order is the same as described above. 

♦ Multiple applications accessing single board:  If you have the added-cost 
SimulStream upgrade, then multiple applications can access a single board.  
This option is described in detail in the SimulStreaming User's Guide. 

Multiple Opens is much more precise and flexible for custom applications that use the 
Osprey-100 Software Developers’ Kit (SDK). This kit allows you to override the 
default board order to access any board at any time.  

It is recommended that developers of multiple board applications obtain our Video 
for Windows developers’ kit, described in Appendix J. Please inquire at our web site 
http://www.ospreyvideo.com/ for more information. 

http://www.ospreyvideo.com/
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Appendix G - File and Registry Usage 

The following are the files that are written and registry entries that are set when the 
Osprey drivers are installed. This information will allow a technically proficient user 
to remove the Osprey installation if the uninstaller is deleted or damaged. 

Instructions for Windows NT 4.0 

Instructions for Windows 2000 and Windows XP 

 

These instructions are for advanced users only! Refer to Chapter 3 - 
Installing the Software - Windows 2000, Chapter 4 – Installing 
the Software – Windows XP, or Chapter 5 - Installing the Software 
- Windows NT 4.0 to remove the software. Be careful not to delete or 
alter any items other than the ones described here! 
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Instructions for Windows NT 4.0  

1. Entries are added in the multimedia and system portions of the registry. When 
manually removing the software, use the Control Panel to “Remove” the driver 
(and delete these entries) before deleting individual files and registry entries. 

2. In the main Windows NT ..\System32 directory, these files can be removed: 
o100vc.dll 
o2ca_mix.dll 
o2ca_usr.dll 
o2ca_wav.dll 
o200board.dll 
SimulKey2.dll 
otiyuv.dll 

3. In the main Windows NT..\System32\drivers directory, these files can be 
removed: 
o100drv.sys 
o2ca.sys 

4. The Osprey Capture Driver directory, its subdirectories, and its files can be 
removed. Typically this directory is \Program Files\Osprey Multimedia Capture 
on the default drive. The installation procedure puts the following files in that 
directory: 
amcap.exe 
CropApp.exe 
xctlapp.exe 
osprey.ico 
Osprey-200 Special Offers.url 
SimulStreaming Users Guide.pdf 
VidCap32.exe 
VidCap.hlp 
license.txt 
Driver Directory 

5. The installation program also creates a directory called NT within the Osprey 
MultiMedia Capture install directory which contains the following files: 
CroppingManual.pdf 
files DelsL*.isu 
Osprey Bird only_dark gray1.bmp 
Osprey Bird only_light gray.bmp 
Osprey Bird dark_gray.bmp 
Osprey Bird light_gray.bmp 
Osprey Video_darkgray.bmp 
Osprey Video_lightgray.bmp 
Osprey100-200_Manual.pdf 
Osprey210-220_Manual.pdf 
ReadMe.txt 
VCST1.bmp 
VCST2.bmp 
VCLogo.bmp 
the Help subdirectory and all its contents 
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6. In the registry, the following branches are added and can be deleted without 
affecting the rest of the system. Use RegEdit to delete them. 

 

In this branch of the registry, the "1" on wave, mixer, and msvideo may 
be a different numeral or may not be present. The descriptive text 
"Osprey Capture Card 1" may be different; there can be "Osprey Default 
Card" present, and the numerals on the capture cards may be different. 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Drivers32 entries: 

"wave1"="o2ca_wav.dll" 
"mixer1"="o2ca_mix.dll" 
"msvideo1"="o100vc.dll - Osprey Capture Card 1" 

♦ HKEY_CURRENT_USER\Software\Microsoft\Windows 
NT\CurrentVersion\Drivers32\vidc.i420 

♦ HKEY_CURRENT_USER\Software\Microsoft\Windows 
NT\CurrentVersion\Drivers32\vidc.yuy2 

♦ HKEY_CURRENT_USER\Software\Osprey\Osprey100 
♦ HKEY_CURRENT_USER\Software\Osprey\Osprey200 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\drivers.desc entries: 

"o100vc.dll"="Osprey Video Capture Driver" 
"o2ca_wav.dll"="Osprey Audio Wave Driver" 
"o2ca_mix.dll"="Osprey Audio Mixer Driver" 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Osprey\Osprey100 
♦ HKEY_LOCAL_MACHINE\SOFTWARE\ViewCast Corporation / Osprey Video 

Division\Osprey MultiMedia Capture 
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♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Unins
tall\Osprey MultiMedia Capture 

♦ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\o100drv 
♦ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\o2ca 
♦ HKEY_USERS\.DEFAULT\Software\Osprey\Osprey100 

7. You can delete the Taskbar entry by selecting Taskbar Properties-> Start Menu 
Programs -> Remove. 

Instructions for Windows 2000 and 
Windows XP  

1. Entries are added in the multimedia and system portions of the registry. When 
manually removing the software, use the Control Panel to " 

2. In the main Windows 2000 ..\System32 directory, these files can be removed: 
o100vc.dll 
o2ca_mix.dll 
o2ca_usr.dll 
o2ca_wav.dll 
o200board.dll 
OtiPnp.dll 
SimulKey2.dll 
otiyuv.dll 

3. In the main Windows 2000 ..\System32\drivers directory, these files can be 
removed: 
o100drv.sys 
o2ca.sys 

4. The Osprey MultiMedia Capture install driver directory, its subdirectories, and 
its files can be removed. Typically, this directory is \Program Files\Osprey 
MultiMedia Capture on the default drive. The installation procedure puts the 
following files in that directory: 
amcap.exe 
CropApp.exe 
xctlapp.exe 
o100drv.inf 
osprey.ico 
Osprey-200 Special Offers.url 
SimulStreaming Users Guide.pdf 
VidCap32.exe 
VidCap.hlp 
license.txt 
Driver Directory 
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5. The installation program also creates a directory called NT within the Osprey 
MultiMedia Capture install directory which contains the following files: 

CroppingManual.pdf 
files DelsL*.isu 
Osprey Bird only_dark gray1.bmp 
Osprey Bird only_light gray.bmp 
Osprey Bird dark_gray.bmp 
Osprey Bird light_gray.bmp 
Osprey Video_darkgray.bmp 
Osprey Video_lightgray.bmp 
Osprey100-200_Manual.pdf 
Osprey210-220_Manual.pdf 
ReadMe.txt 
VCST1.bmp 
VCST2.bmp 
VCLogo.bmp 
the Help subdirectory and all its contents 

6. In the registry the following branches are added and can be deleted without 
affecting the rest of the system. Use RegEdit to delete them. 

 

In this branch of the registry, the "1" on wave, mixer, and msvideo may 
be a different numeral or may not be present. The descriptive text 
"Osprey Capture Card 1" may be different; there can be "Osprey Default 
Card" present, and the numerals on the capture cards may be different. 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Drivers32 entries: 

"wave1"="o2ca_wav.dll" 
"mixer1"="o2ca_mix.dll" 
"msvideo1"="o100vc.dll - Osprey Capture Card 1" 

♦ HKEY_CURRENT_USER\Software\Microsoft\Windows 
NT\CurrentVersion\Drivers32\vidc.i420 

♦ HKEY_CURRENT_USER\Software\Microsoft\Windows 
NT\CurrentVersion\Drivers32\vidc.yuy2 

♦ HKEY_CURRENT_USER\Software\Osprey\Osprey100 
♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 

NT\CurrentVersion\drivers.desc entries: 

"o100vc.dll"="Osprey Video Capture Driver" 
"o2ca_usr.dll"="Osprey Audio Driver" 
"o2ca_wav.dll"="Osprey Audio Wave Driver" 
"o2ca_mix.dll"="Osprey Audio Mixer Driver" 

♦ HKEY_LOCAL_MACHINE\SOFTWARE\Osprey\Osprey100 
♦ HKEY_LOCAL_MACHINE\SOFTWARE\Osprey\Osprey200 
♦ HKEY_LOCAL_MACHINE\SOFTWARE\ViewCast Corporation / Osprey Video 

Division\Osprey MultiMedia Capture 
♦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Unins

tall\Osprey MultiMedia Capture 
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♦ HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Control\MediaResources\msv
ideo\!default entry: "Driver" = "o100vc.dll - Osprey Capture Card 1" 

♦ HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Control\MediaResources\msv
ideo\!default entry: "Driver" = "o100vc.dll - Osprey Capture Card 1" 

♦ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\MediaResources\
msvideo\!default entry: "Driver" = "o100vc.dll - Osprey Capture Card 1 

♦ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\o2ca 
♦ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\o100drv 
♦ HKEY_USERS\.DEFAULT\Software\Osprey\Osprey100 

7. You can delete the Taskbar entry by selecting Taskbar Properties -> Start 
Menu Programs -> Remove.  
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Appendix H - Adding/Moving Boards in 
Windows 2000 and Windows XP  

Under Windows 2000 and Windows XP, when the Osprey MultiMedia Capture driver 
has been installed and another Osprey board is put into a slot that has not previously 
contained a board, the following sequence is initiated. This can happen because an 
Osprey board has been moved to a different PCI slot or when a board is being added 
to the machine. It occurs because of the manner in which Windows 2000 or Windows 
XP enumerates devices. 

The New Hardware Wizard runs and displays the Found New Hardware window 
followed by the Digital Signature Not Found window. 

 

 

1. Click Yes. 
The Multimedia Controller installing window (not shown) displays, and the text 
inside this window changes to "Osprey Video Capture Device, Installing ..." . 
Then the Digital Signature Not Found window appears on top of it. 
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2. Click Yes. 
The Completing the Found New Hardware window displays. 

3. Click Finish. 
The Digital Signature Not Found window displays. 

4. This window displays once for each Osprey board you are installing. 
The Systems Setting Change window displays. 

5. Click Yes to restart the computer. 

 

You must restart your computer to complete the installation.  Do not 
attempt to use your Osprey card until after restarting the system. 
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Appendix I - The Audio Cfg Applet 

The Audio Settings applet has been removed from the release.  Please see Registry 
Settings Controlled by the Audio Cfg Applet for information on how to change 
the Rate Conversion Selection and Gain Selection. 

Registry Settings Controlled by the Audio 
Cfg Applet  

The Audio Settings applet places registry values in these twigs of the registry: 

♦ HKEY_CURRENT_USER\SOFTWARE\Osprey\Osprey200\DeviceX\Audio\RateCo
nversion 
RateConversion may be set to 1, 2, or 3 only. 

When RateConversion is: 

1 - use filter converter (default) 

2 - use skip converter (skips samples) 

3 - use Microsoft PCM method 

♦ HKEY_CURRENT_USER\SOFTWARE\Osprey\Osprey200\DeviceX\Audio\Gain 
The default value of Gain is 2. Set it higher for increased software audio gain. 
Set it below 2 to decrease gain. 
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Appendix J - Developer Support 

The Osprey Technologies group has a software developers’ kit (SDK) to assist 
development of specialized Video for Windows applications. The kit provides 
capabilities that the Video for Windows API does not provide. It uses a proprietary 
interface that bypasses Video for Windows and connects your application directly to 
the Osprey video capture driver. 

The developers’ kit at present has the following modules: 

♦ Methods by which a single application can access multiple boards - see also 
Appendix F. 

♦ Interactive control of video source, brightness, contrast, hue, and saturation 
from inside an application 

♦ A Closed Captioning API, by which the application can control Closed 
Captioning and capture Closed Caption text for specialized processing and 
display. 

♦ An API for Controlling on-video logos - see Chapter 5, The Logo Page. 

♦ An API for capture of raw Vertical Blanking Interval (VBI) data. 
♦ Direct access to the Bt878 registers. 
♦ An API for controlling cropping parameters – see the CropApp documentation. 

♦ A sample Audio Mixer program. 
♦ For more information, visit our web site at http://www.ospreyvideo.com/ 

and click Support.  

http://www.ospreyvideo.com/
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